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Sazetak

Ovaj zavrsni rad opisati ¢e Uvodenje robotizacije u industrijski proces za potrebe tehnoloske
operacije povrSinske zastite.

U prvom dijelu ¢e se objasniti procesi i sustavi povrSinske zastite (bojanje, plastifikacija i
sve rijede bitumenizacija), te priprema povrSina (saCmarenje) prije samog postupka zastite.
Primjeri postrojenja u realnom sektoru proizvodnje kao $to su linija za plastifikaciju u
fluidiziranom sloju i linija za bitumeniziranje vodenim postupkom. Priblizno sli¢nu liniju za
lakiranje prikazati ¢e se pomocu programskog alata V- REP. U programu ¢e biti odabrani robot
za bojanje KUKA koji rasprSivanjem nanosi boju na radni komad kojeg ¢e rotirati pozicioner.
Stalak ,,Viktorija zdenac* posluziti ¢e kao model radnog komada koji ¢e se okretati dok robot na
njega nanosi slojeve boje. Buduci da je V- REP najnapredniji i vrlo prilagodljiv simulator,
moguce ga je koristiti i u podrucju virtualne stvarnosti (VR) za potrebe programiranja pokreta
preko VR naocala i kontrolera.

Drugi dio i glavna tema ovog rada je izradivanje i simuliacija ¢elije za bojanje robotom u
programskome alatu V- REP. Opisati ¢e se postavljanje kinematike robota KUKA i senzora za
prihvat rasprsivaca te postupak umetanja modela stalka iz Solid Edge-a u V- REP i njegove
putanje koja ¢e sluziti za upravljanje robotom iz skripti preko funkcija programskog jezika Lua.
Pozicioner koji ¢e okretati radni komad dok robot preko putanje vrsi bojanje upravljan je takoder
iz skripte sa svojim funkcijama i1 parametrima. Na kraju ¢e se prikazati dijelovi ostalih
proizvodnih procesa prije i poslije samog postupka bojanja, te zastitni uvjeti kako za ljude tako i
za okolis.

Nakon §to se izradi robotska celija za bojanje, simulacijom se pregledava sami postupak

nanosa boje na radni komad.

Kljucne rijeci: bojanje, plastifikacija, robot, ¢elija za bojanje, stalak, V-REP, VR, Lua



Abstract

This final paper will describe the introduction of robotization into the industrial process for
the purposes of a technological surface protection operation.

The first part will explain the processes and systems of surface protection (painting,
plastification and less frequently bitumenisation), and the preparation of surfaces (shot blasting)
before the protection process itself. Examples of installations in the real manufacturing sector
include fluidized bed plastification line and water bitumenisation line. A roughly similar painting
line will be displayed using the V-REP software tool. The program will select the KUKA
painting robot that will spray paint onto a workpiece that will be rotated by the positioner. The
stand ,,Viktorija zdenac* will serve as a workpiece model that will rotate as the robot applies
layers of paint on it. Because V-REP is the most advanced and highly customizable simulator, it
can also be used in virtual reality (VR) for motion programming via VR glasses and controllers.

The second part and mainly the main theme of this final paper is to design and simulate a
robot painting cell in the V-REP software tool. It will describe the setting of the kinematics of
the KUKA robot and the spray sensor. The process of inserting a stand model from Solid Edge
into V-REP and its path will be used to control the robot from scripts via the functions of the Lua
programming language. The positioner who will rotate the workpiece while the robot is painting
the path is also controlled from the script with its functions and parameters. Finally, parts of
other manufacturing processes will be presented before and after the painting process itself, as
well as the protective conditions for both humans and the environment.

After the robotic painting cell is created, the simulation examines the process of applying the

paint to the workpiece itself.

Keywords: painting, plastification, robot, painting cell, stand, V-REP, VR, Lua



Popis koriStenih kratica

V- REP  Virtual robot experimentation platform
Virtualna platforma za eksperimintiranje robota

VR Virtual Reality
Virtualna stvarnost

API Application programming interface
Sucelje za programiranje aplikacija

CAD Computer Aided Design
Oblikovanje s pomocu racunala

CIM Computer Integrated Manufacturing
Proizvodnja integrirana raCunalom

AKZ Antikorozivna zastita

PLC Programmable Logic Controller

Programblini logicki kontroler

CNC Computer Numerical Control
Racunalno numeri¢ko upravljanje

KRL Kuka Robot Language
Programski jezik Kuka robota

3D 3 Dimensional
3 Dimenzijski prikaz
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1. Uvod

Razvojem tehnologije u novije vrijeme racunala upravljaju i povezuju sve dijelove
proizvodnog procesa. Pored kompjuterizacije vrlo je vazna i robotizacija koja predstavlja spoj
strojeva i raCunalne tehnike. Nagli tehnoloski napredak doveo je do sve Sire primjene robotike u
gotovo sva podrucja ljudskog djelovanja kao Sto su informatika, elektronika, mehanika i
automatika, ¢ime su postavljeni temelji za razvoj suvremenih robota. Kompjuterizirane
tehnologije obuhvacaju ra¢unalno poduprtu konstrukciju (CAD), numeri¢ke upravljane strojeve,
fleksibilne proizvodne sustave, industrijske robote, racunalom integrirana proizvodnja (CIM) te
primjenu umjetne inteligencije.

Industrijski roboti pojavili su se onog trenutka kada je tehni¢ko- tehnoloski razvoj dostigao
potrebnu razinu radi Zelje za oslobadanjem covjeka od nehumanog, monotonog i opasnog
fizickog rada i nastojanja za povecanjem profita. Upotrebom robota u industriji, smanjuje se
ljudski faktor greske i vrijeme operacija se svodi na minimum, te SU pouzdaniji i puno brzi od
covjeka. Vrlo brzo se pokazalo da se klasi¢ni oblici proizvodnje nisu mogli ,,natjecati sa
modernim kompjutorskim i robotiziranim sustavima proizvodnje [1].

Danas u industriji postoji veliki broj primjena gdje se roboti mogu efikasno upotrijebiti, od
transporta i manipulacije, pa sve do procesnih operacija poput brusenja, glodanja, busenja,
zavarivanja, bojanja itd.

Uvodenjem robota za bojanje smanjuje se izlaganje ljudi otrovnim supstancama. Zbog
posebnog dizajna, roboti koji se koriste za bojanje otporni su na teSke uvjete i ne predstavljaju
opasnost u blizini zapaljivih tvari ili u eksplozivnoj atmosferi. Robotski sustavi za bojenje su
pogodno rjeSenje Cak 1 za situacije u kojima je potrebno oponasati ljudsku ruku, jer ih je moguce
vrlo precizno programirati za takve zadatke. KoriStenjem robota dolazi do smanjenja potrebe
ljudskog fizickog rada, ali naravno tu dolazi do potrebe usavrSavanja i edukacija ljudi za
programiranje [2].

Svrha ovog rada jest da se poblize objasne procesi i sustavi povrSinske zastite bojanja,
plastifikacije i bitumenizacije u realnom proizvodnom sektoru. Pored linije za bitumenizaciju i
linije za plastifikaciju robotom potreba za uvodenjem linije za lakiranje robotom u buduénosti je
neizbjezna. Razvoj i funkcioniranje celije za lakiranje robotom prikazati ¢e se u programskome
alatu V-REP. Simulirati ¢e se robotska celija za lakiranje sa 7 stupnjeva slobode gibanja koje

izvode robot i pozicioner.



2. Procesi i sustavi povrsinske zastite

Stete koje nam nanosi korozija vrlo su velike pa se neprekidno traZe nacini kako da se ona

suzbije. Budu¢i da su uzroci korozije razliCiti, primjenjuju se i raznovrsni nacini obrane.

Razvijanje korozije moze se sprijeciti na nacin da se metalne povrSine izoliraju od tvari koje

izazivaju koroziju. U tu svrhu primjenjuju se prevlake koje onemogucavaju zraku, vodi, morskoj

vodi, plinovima, Kiselinama i drugim kemikalijama da dodu u dodir s metalnim povr§inama.

Zastitnim prevlakama poklanja se osobita vaznost jer se pomocu njih poveéava trajnost i

proSiruje mogucénost primjene metala neotpornih prema koroziji. Pored toga, zaStitnim se

prevlakama uljepsava izgled metalnih dijelova.

Koji ¢e se materijal odabrati za prevlake, ovisi o:

raspolozivim tehnickim sredstvima;

materijalu koji treba zastititi od korozije;

- vremenskoj trajnosti koja se Zeli posti¢i zaStitom;

ekonomicnosti zastite od korozije [3].

Maksimalna

- Brzina kerozije, mm,’gOfi.__ Specijalni
Metal ilf legura ..,,‘:.’ZZ,‘I".’,";.P u gradskoj umorskol | u HaSO. u HNO, u NaOH oblici
éem zraku,’C atmosferi vodi | (5%) (5%) (5%) razarans
Ugljiéni Zelik 570 00302 | 0,003..03 0410 | vrdo velika | do 0005 kaustitna kriost |
" Sivi lijev 570 001--0,1 02-2 3 3 00505 saliacin; sate. |
Faool. 650 do 0,005 do 008 do 043 do 05 do 03
et | do 001 do 01 vrlo velika | 008.-09 do 01 e
e w0 865 do 0,005 do 0,05 013 do 005 do 0,05 b
Krom 1000 do 0,01 dool | 063 oko 03 | do o1 o
© Nikal ) 800 do 0,05 00505 0051 1.-10 do 0,005
Bakar 00 | doo00s 005- 0,5 0081 vrlo velika. | 005..05
| R e 750 do 0,03 005.-05 005.-0,8 vilo velika | 00505 g::ﬁﬂgm
Cok 400 do 001 00103 | wrlo velika | vrlo velika 045 s
Kadmij o 280 do 0:0717 ‘ “do 0,01 vrio velika vrlo velika do 0,1 -
Olovo 300 | do000S | 000504 do 005 25..15 0,15--15 i
Kositar R 200° do 0,005 do 0003 0.05:15 LS~--I_0 0,131 wkugae, amnlgamiranjc“
Alu;z;a;j—.___ i 600 do;],‘OIJ 0,03---13 . 02-- 2_,5 042 vrlo velika
[ Magnezijove legure 200 002.-005 | wrlo velika | vrlo velika | vrlo velika | 0,03.-03 ]
Than i 750 0 0 025.25 | 0003003 | do 0,005 -
Srebro 960 0 o do 003 | wrlo velika 0 smalgamiranje |
A i;o o 1063 - _6_ 0 0 0 0 7 amalgamiranje
 Platina 1769 0 0o 0 o o  krtost
Rodij 1960 o 0 o | o 0

Slika 2.1 Korozijsko ponasanje nekih metala [4]
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Postoji mnogo materijala koji se upotrebljavaju za zastitne prevlake, ali se gotovo sve
prevlake mogu razvrstati u metalne, oksidne i nemetalne prevlake.

Zastita od korozije organskim nemetalnim prevlakama najzastupljenija je i s njom se ljudi
najvise susrec¢u u zivotu. Konkretno misli se na tekuce premaze koji se svojom jednostavnoscu
ve¢ desetlje¢ima namecu kao naj¢esce odabrano zastitno sredstvo. Cijena 1 lakoca upotrebe samo
su neke od njihovih prednosti.

Prevlake se dobiju nanoSenjem organskih premaznih sredstava (bojenjem i lakiranjem),
bitumenizacijom i plastifikacijom. Pritom, uinkovitost zaStite ne ovisi isklju¢ivo samo o
svojstvima prevlake ve¢ 1 o karakteru same metalne osnove, pripremi povrsSine i tehnologiji
nanosenja prevlake. U praksi je stoga neophodno uzeti u obzir cijeli sustav i tehnologiju
izvodenja zastite ukljucujuci i najcesée kompliciran sastav same prevlake.

Premazi su teku¢i ili praskasti proizvodi u kojima su sadrzani pigmenti, a naneseni u vrlo
tankim slojevima na podlogu prelaze u tvrd, dobro prianjajuéi film, koji sluzi u zastitne i/ili
dekorativne svrhe [4].

Osnovni cilj nanos$enja premaza je razdvajanje metalne podloge i okolisa pa stoga oni moraju
biti dovoljno postojani i trajni u uvjetima eksploatacije. Tako je i najvaznije tehni¢ko svojstvo
premaza njihova trajnost.

Sustav zastite premazima sastoji se obi¢no od temeljnog sloja, jednog ili vise meduslojnih
slojeva te zavr$nog sloja, od kojih svaki ima svoju ulogu. Opéenito se moze re¢i da je premaz
materijal koji je nakon nanoSenja na podlogu stvorio ¢vrsti film.

Materijali za prevlacenje u kontaktu s pitkom vodom ne smiju otpustati nikakve tvari koje bi
utjecale na okus, miris ili boju vode za pice ili na rezultat rasta mikroorganizama.

Povrsine koje se prevlace organskim prevlakama moraju biti oCiS¢ene od necistoca, ulja,
masti, vlage, korozije ili drugih oneciS¢ujucih tvari saémarenjem.

Priprema pozicija za postupak sa¢marenja izvodi se odgovaraju¢om zaStitom toleriranih
dosjeda 1 navojnih provrta. Za zastitu povrSina upotrijebljava se guma ili silikonski zastitni
¢epovi, samoljepljive trake za saémarenje ili Celi¢ne zaStitne naprave i limove.

Odljevci koji su sacmareni smiju se premjestati jedino uz upotrebu rukavica koje ne otpustaju
vlakna, te ih treba $to prije prenjeti u pe¢. Ako je period ¢ekanja dulji, osaémarene odljevke treba

zastititi prekrivanjem i skladistiti na suhom [5].



Slika 2.2 Jedinica za sacmarenje odljevaka [5]

Zahtjevani stupanj oci$¢enosti povrSine je Sa 2Y ili ve¢i prema ISO 8501-1 cCelicnom
lomljenom sa¢mom, uz hrapavost saémarene povrsine 40-75 um za povrSine koje se prevlace

bojom, odnosno minimalno 60 um za povrsine koje se prevlace prahom [5].

Slika 2.3 Izgled povrsine cistoée Sa 2% [5]



2.1. Bojanje

Bojanje je vrlo poznat nacin za zaStitu metalnih povrsina od korozije. Boja se nanosi na ¢istu
osusenu povrSinu bezraCnim raspriSivacem (airless), zracnom Spricom, valjkom, kistom,
prelijevanjem boje po povrsini ili uranjanjem pozicije u smjesu boje. Na Zeljezni komad kad je
pripremljen nanose se boje u vise slojeva. Osnovni temeljni sloj, koji se nanosi prvi, treba dobro
prijanjati za povrSinu i sam ne smije uzrokovati koroziju, a antikorozijska svojstva premaza
sadrzana su u inhibiraju¢im pigmentima. Medusloj u sistemu pojac¢ava zaStitna svojstva i
prijonjivost izmedu dva sloja, te barijerni efekt (pigmentacija laminarne strukture). Gornji
zavrS$ni sloj, odreduje kona¢nu boju, nijansu, sjaj, povrSinsku otpornost i elasti¢nost na
djelovanje atmosfere i tekucine, te ostala posebna svojstva [3, 4].

Ovisno o temperaturi okoline (zimsko/ljetno razdoblje), prije nanosenja boje pozicije treba
zagrijati unutar komore za bojenje. Nepovoljna temperatura povrSine u odnosu na uvjete u
komori uzrokuje rosenje povrSine (kondenzacija vlage iz zraka) i naruSava kvalitetu zaStitnog

premaza [6].

Nepropustan sloj za Oz, CO,

Niska propusnost viage

Zavrsni *
Meduslo) e——1— v
Temel| ‘

Kvalitetna prionjivost
temelja

U medusloju nema praznina koje bi zadrZavale vodu

Slika 2.4 Prikaz pojedinih slojeva premaza [7]

Svi premazi imaju i svoje osnovne komponente:

- Vezivo je smjesa prirodnih ili sintetickin smola i drugih kemijskih komponenata.
Neisparljivi je dio medija boje, povezuje sve komponente premaznog sredstva i stvaraju
tvrdi zasStitni sloj. (Susiva ulja, smole, derivati celuloze...).

- Otapalo ili razrjediva¢ su obic¢no hlapljivi organski spojevi u kojima se otapa vezivo i
regulira viskoznost premaza, te omogucéavaju postizavanje to¢ne debljine suhog filma. Ne

dolazi do kemijskih promjena. (Ugljikovodici, alkoholi, esteri, ketoni...).



- Pigment je sastojak premaza koji daje pokrivhu mo¢, pojacava film premaza, daje mu
boju, utjee na postojanost filma i §titi od UV zracenja.

- Punilo su bijele ili slabo obojene, netopljive anorganske tvari. Poboljsavaju mehanic¢ka
svojstva, mazivost, svojstva teCenja. Reguliranje sjaja i poboljsanje barijernih svojstava
omogucavajuci nanoSenje debljih premaza.

- Aditivi imaju funkciju kontroliranja susenja premaza. Mali udio u premazu, znacajan
utjecaj na svojstva. Koriste se za sprijeCavanje nedostataka u premazima (pjena,

sedimentacija...) ili za davanje specifi¢nih svojstava (klizavost, svjetlostabilnost...) [4].

Uvjeti prilikom bojanja ovise o postupku planiranja svih aktivnosti, odgovaraju¢im radnim
uvjetima, ispravnom odabiru metode, povoljnim mikroklimatskim uvjetima te vjestini radnika.
Izbor materijala za AKZ (Antikorozivnu zastitu) je definiran radnim nalogom s to¢no
specificiranim tipovima premaza, katkad su definirani razliciti sustavi bojenja za vanjske i
unutarnje povrsine proizvoda. Procesi su razradeni od pripreme i zastite povrSine, pri cemu treba
uzeti vrijeme potrebno za montazu i demontazu skele, susenje, otvrdnjavanje i za medupremazne
intervale, te mikroklimatske uvjete (temperaturu podloge, rosiste, okolnu temperaturu, relativnu
vlaznost i temperaturu boje).

U zatvorenom ili ograni¢enom prostoru potrebno je instalirati ventilaciju zbog opce
sigurnosti, a i isto tako i zbog suSenja premaza. Nadalje, premaz se nanosi kod relativne
vlaZznosti manje od 85%, jer previsoka relativna vlaznost moze uzrokovati roSenje povrsina.
Temperatura boje je takoder vazna, jer kod niskih temperatura neke se dvokomponentne boje
nece stvrdnuti, zato Sto kemijska reakcija izmedu veziva i otvrdnjivaca gotovo prestaje. Takoder,
kod opadanja temperature, viskoznost boje raste, §to rezultira slabom rasprsljivos¢u boje tj. boja
se tesko nanosi [6, 8].

Prije nano$enja boje povrsina mora biti Cista i suha! Bojiti je potrebno za suha vremena, kada
su temperature iznad 5°C, izbjegavajuci direktan utjecaj suncevih zraka. Kako bi se izbjegla
kondenzacija, temperatura povrSine mora biti iznad tocke roSenja. To se moze provjeriti na vrlo
jednostavan nacin: krpom navlazite povrSinu, pa ako se ona osusi nakon 10 do15 minuta, mozete
zapoceti s bojenjem. Kod dvokomponentnih je premaza pozeljno da mjesavina odstoji desetak
minuta prije upotrebe. Jednokomponentni se premazi isporucuju veé¢ spremni za nano$enje
kistom, valjkom ili rasprSivatem. Ako se lakirana ili obojena povrSina ne osusi prije nego se
poveca stupanj vlage u zraku, ili prije nego padne rosa primjerice, ona moze poprimiti mat
izgled, S$to znaci da je paZljivo planiranje nanoSenja pojedinih premaza od velikog znacaja za

postizanje dobrog rezultata.



Nakon §to se pazljivo pripremi povrSina slijedi nanoSenje premaza. Boja se ne nanosi pri
visokoj vlazi niti na temperaturama ispod 10°C kod dvokomponentnih premaza ili 5°C kod
jednokomponentnih boja. Najbolji je nacin nanoSenja temeljnih boja, a da se pritom izbjegne
nastajanje rupica, pomocu kista ili rasprsivaca. Medupremazi i zavrs$ni premazi mogu Se nanositi

kistom, valjkom i, dakako, rasprsivacem [9].

Slika 2.5 Postupak bojenja rucnim rasprsivacem [6]

Debljina sloja boje (mokri postupak) mora biti izmjerena na svim bojanim pozicijama koje su
obojane zavrSnom bojom. Mjerenje se vr$i neposredno prije premjeStanja pozicije izvan prostora
za lakiranje. Ukoliko izmjerena debljina povrSinske zastite ne odgovara specifikaciji, povrSinska
zastita se doraduje.

Kod svakodnevnog rada sa premazima ponekad dolazi do greSaka koje nisu posljedica
njihove lose kvalitete, ve¢ Cesto nastaju zbog nedovoljnog poznavanja i nepravilne upotrebe
materijala, loSih uvjeta aplikacije i nepravilne tehnike nanosenja.

Vrlo je vazno znati analizirati takve greSke, otkriti uzrok i $to je najvaznije otkloniti uzrok i
popraviti greske. Pokazati ¢e se neke najvece greske pri lakiranju, koji se susre¢u u praksi,

definirati uzorke i dati uputstva za njihovo sprije¢avanje [10].
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Stvaranje mjehurica

Uzroci:
» prekratko vrijeme otparavanja medu slojevima
predebeli slojevi nanesenog predlaka
ostaci vode od bruSenja u kutovima, na rubovima, pregibima i pod ukrasnim letvicama
previsoka tvrdoca vode za brusenje
onecidten komprimirani zrak
previsoka relativna viaZnost zraka (nad 80% kod 2K materijala)
nastajanje kondenzacije zbog temperaturnih promjena

Spriecavanje:
@ minimalno otparavanje medu slojevima 10 min/20 °C
kod jednokratnog nanogenja max. 20 um za HS prediak i max. 40 pm za MS predlak
po mogucnosti uvijek demontirati sastavne dijelove
temeljito ispuhati
ne dopustiti da se ostaci vode od brudenja osude, obrisati ih dok su mokri
komprimirani zrak mora biti suh i dist
izbjegavati nastajanje kondenzacije. osigurati stalnu
temperaturu i vlagu

Popravak nastalog defekta:
@ izbrusiti do lima i lakiranje predlaka ponoviti po uputama

Slabo prianjanje na podlogu

Uzroci:
@ slabo pripremljena podloga, tragovi masnode, ofisaka prstiju, pragine
@ uporaba materijala koji nisu primjereni Za odredens vrste limova
@ razrjedivanje materijala neodgovarajucim (neoriginalnim) razrjedivacem

Sprietavanje:
iz @ povréinu prije lakiranja dobro odistiti
¥ — @ Uvijek provjeriti koji se materijal moZs nanositi na odredenu vrstu lima
= @ uporaba propisanih razrjedivaca

Popravak nastalog defekta:
@ izbrusiti do lima i lakiranje predlaka ponoviti po uputama
w paziti na pravilan izbor 2K predlaka u odnosu na poedlogu

Krateri

Uzroci:
« ostaci voska, masnoce, silikona
@ komprimirani zrak zagaden ostacima kondenzacije il ulja
@ upotreba silikonskih polimih sredsteva il sprejeva
e nedovolino ofiZtena povriina prije lakiranja

Spriecavanje:
e prije podetka lakiranja temeljito odistiti MOBIHEL Antisilikonskim Sistilom low VOC
@ redovno odrZavanije filtera za izluivanje ulja i vode

Popravak nastalog defekta:
@ izbrusiti do prediaka i lakiranje pokrivnog premaza ponoviti po uputama

Zakuhavanije

Uzroci:
@ nedovoljino osusen predlak
w« zatvaranje otapala i zraka predebelim slojevima premaza
@ kod nanogenja pojedinih slojeva nije bilo ofparavanja
@ upotreba neodgovarajuceq utvrdivaca ili razrjedivaca
@ prekinuto suenje (nepridriavanje vremena sugenja)

Spriecevanje:
« nanijeti propisanu debljinu premaza
e medusoljni interval treba biti 10-15 min.f20°C
« redovito provjeravati rad i temperaturu susila
« pridrZavati se propisanin vremena otparavanja izmedu nanoéenja pojedinin slojeva i konaénog
otparavanja
@ upotreba propisanog utvrdivada i razriedivaca

Popravak nastalog defekta:
@ izbrusiti do lima i ponoviti [akiranje predlaka i pokrivnog premaza po uputama

Slika 2.6 Uzroci i sprijecavanje nekih gresaka pri lakiranju [10]
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2.2. Plastifikacija

Zastita okoliSa znacajno je utjecala i na povecanu upotrebu polimernih prevlaka koje se
nanose u ¢vrstom stanju za zastitu razlicitih konstukeijskih materijala od korozije, obzirom da
kod postupaka plastifikacije ne dolazi do isparavanja hlapljivog otapala koje znacajno opterecuje
okolis.

Plastifikacija je metoda povrSinske zasStite metala od korozije nanoSenjem praha, te
polimerizaciji praha na odredenoj temperaturi. Plastificiranje metala je postupak kojim se po
naelektriziranom komadu metala, posipa obrnutog polariteta nabijeni prah u pistolju za
elektrostatsko prasenje, te se na taj nacin prah lijepi i po dijelovima koji nisu na direktnom udaru
praha. Elektricitet privlaci prah gdje ga nema, a odbija gdje je nanesen. U daljnjem posipanju,
prah se ponasa kao izolator, jer je poliuretanskog sastava, pa novi sloj praha otpada sa
pokrivenog dijela, te imamo ravnomjerno rasporeden sloj koji se tijekom polimerizacije na cca

180°C pretvara u ravnomjeran sloj zastitne plastike [11].

Slika 2.7 Prah za plastifikaciju [12]



Plastificirani sloj, osim Sta je odlicna zaStita od korozije, otporan je na toplinu i1 abraziju.
Plastificiranje zadovoljava suvremene ekoloske standarde, te je za okolinu i zdravlje
najprihvatljivija metoda oplemenjivanja metala. Osim navedenih svojstava, plastifikacija
omogucava 1 neogranicen izbor boja, razlicite povrSinske strukture.

Postupcima plastifikacije se na razli¢ite metalne 1 nemetalne proizvode nanose prevlake od
plasticnih masa, najces¢e vecih debljina (od 0,2 do 0,5 mm). lako su po svom sastavu ove
prevlake vrlo slicne premazima s poliplasticnim vezivima, uvelike se razlikuju od njih po
tehnologiji nanoSenja.

Za nanoSenje polimernih prevlaka razvijen je veliki broj postupaka, od kojih su najvazniji:
lijepljenje i oblaganje, vruce prskanje, nataljivanje, fluidizacija i elektrostaticko naprasivanje. Od
nabrojenih postupaka nanosSenja polimernih prevlaka najveci tehnicki znacaj imaju postupci

elektrostatskog naprasivanja i fluidizacije [8, 13].

Slika 2.8 Rucna plastifikacija epoxy prahom [13]

Elektrostaticko naprasivanje vrlo Cesto naziva se 1 suhim li¢enjem, stoga Sto se kod ovog
postupka plastifikacije metalnih podloga ne primjenjuje razrjediva¢ niti otapalo, ve¢ se nanosi

suhi polimerni praSak [8].

SACMARENJE PREDGRIJAVANJE PLASTIFIKACUA

cistoca povriine: Sa 2, 5// 200 - 220°C (RAL-GZ 662 2014)
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Slika 2.9 Predgrijavanje komada i komora za fluidizaciju [13]

Fluidizacija je postupak nanoSenja polimerne prevlake zagrijani predmet ,,uranja“ se u
uskovitlani sloj poliplasta koji nastaje propuhivanjem zraka ili duSika kroz porozno dno
posebnog spremnika. U pravilu, predmeti se zagrijavaju na 100 do 200 °C iznad taliSta
poliplasta. Ovisno o debljini podloge, kao i vrsti praha koji se nanosi, temperature predgrijavanja
krecu se od 180 do 400 °C, te su znatno viSe nego kod elektrostatskog naprasivanja. Ovisno 0
toplinskom kapacitetu obradivanog predmeta, tj. podloge, kao i o temperaturi predgrijavanja i
vremenu uranjanja u sloj uskovitlanog polimernog praha stvara se prevlaka taljenjem
sinteriranog polimera izvan samog spremnika. Uobicajene debljine prevlaka koje se mogu
posti¢i jednim uranjanjem krecu se od 200 do 500 pm, a u posebnim sluc¢ajevima moguce je
postici prevlake debljine i preko 1 mm [8].

Na pozicije predvidene za dvoslojno oblaganje prahom, nanosi se zavrsni sloj poliesterskog
praha (50 um). Postupak se obavlja u istom ciklusu, odmah po zavr$etku nanoSenja prvoga sloja
obloge.

Prevlaka od epoksi praha na gotovom proizvodu mora ispuniti sljedece zahtjeve:

- biti jednolike boje

- biti ujednacenog izgleda i glatkoCe, izuzev dopustenih podrucja na kojima su obavljeni
popravci

- ne smije na njoj biti vidljivih greSaka (rupice, mjehuri, nabori, pukotine ili Supljine
ispunjene zrakom)
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Manje promjene boje na povrSini nastale kao posljedica popravka ili izlaganja suncevoj
svjetlosti tijekom duljih perioda (izbjeljivanje) ili razlike u razinama sjaja radi prejakog prskanja
su dopustene. (Izbjeljivanje je reakcija koja se pojavi na povrSinama prevucenima epoksidom
izloZenima ultraljubiastom zraCenju. Proces je uravnotezen na dubini 2-5 um proizvodima
reakcije i vezan je uz gubitak sjaja. Nema utjecaja na zastitne karakteristike prevlake).

Proizvodi osigurane kvalitete procesa su oznaceni oznakom kvalitete - Udruzenja za
osiguranje kvalitete (Gilitegemeinschaft) antikorozijske zaStite armatura i fazona u teskim
uvjetima korozije prevlaenjem epoxy prahom, uz informacije koje se odnose na kvalitetu u
skladu sa sljede¢im simbolom oznake kvalitete RAL — GSK [13].

GUTEZEICHEN
~ SCHWERER KORROSIONSSCHUTZ
VON ARMATUREN UND FORMSTUCKEN

RALGZ 662/3

Slika 2.10 Oznaka kvalitete antikorozijske zastite [13]

2.2.1 Primjer postrojenja za plastifikaciju u fluidiziranom sloju

Postrojenje za potpuno automatiziranu plastifikaciju odljevaka u fluidiziranom sloju pomoéu
robota KUKA KR 240. Prije plastifikacije, potrebno je pripremiti povrsinu odljevaka u komori
za sa¢marenje. Odljevci se postavljaju na pokretnu traku ru¢no ili uz pomo¢ dizalice ovisno o
tezini. Pomocu sucelja se unosi kod, primjerice 6- znamenkasta broj¢ana oznaka, koja tocno
oznacCava pojedinu vrstu odljevka. Preko te oznake proizvoda, robot dohvaca sve informacije
vazne za proces plastifikacije:

= V/rsta steznih naprava za prihvat odljevka

= Pokrete robota tijekom postupka prihvacanja, plastifikacije i odlaganja odljevka na traku

= Vrijeme stanke nakon plastifikacije pojedinog proizvoda
Istovremeno je na zaslonu prikazana to¢na pozicija odljevka smjeStenog na pokretnoj traci.

Upravljanje se vrsi pomocu Siemens Simatic S7-1513F SPS (njem. Speicherprogrammierbare
Steuerung - programibilni logicki kontroler). Operacija i ulaz se odvija preko Siemens TP1500

dodirnog zaslona instaliranog na upravljacku konzolu s postoljem [14].
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Slika 2.11 Zaslon upravijacke jedinice peci [13]

Nakon postavljanja na pokretnu traku, odljevci prolaze kroz pe¢ za predgrijavanje. Pe¢ je
podijeljena u dva dijela s jednakim uvjetima zagrijavanja i dostupnim moguénostima regulacije.
U slucaju zagrijavanja tezih odljevaka, zadana temperatura u prvoj polovici peé¢i moze biti
primjerice 250 °C, dok u drugoj polovici moze biti niza (220 °C). Na taj se nacin prema potrebi

moze ubrzati proces predgrijavanja [14].

Slika 2.12 Pe¢ za predgrijavanje odljevaka [13]
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Nakon grijanja, robot opremljen prikladnim steznim napravama automatski izvodi postupak
plastifikacije. Ovisno o geometriji odljevka, robot sa stanice za zamjenu steznih naprava dohvaca
odredenu steznu napravu kojom c¢e prihvatiti odljevak. Slijed pokreta robota tijekom samog
postupka plastifikacije se moze mijenjati po potrebi, tako da se dobije ravnomjerno oblaganje s
moguéno$c¢u ponavljanja istih radnji. Po potrebi, ili za plastifikaciju nove vrste odljevka, slijed

radnji se moZze promijeniti.

Slika 2.13 Plastifikacija robotom KUKA KR 240 [13]
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Fluidizacija praha u bazenu se postize pomoc¢u bo¢nih kanala za upuhivanje komprimiranog
zraka. Usisani zrak iz prostorije prolazi kroz filtar i upuhuje se u bazen kroz otvore u stijenkama
bazena. Kroz sinter plocu zrak ustrujava u prahom ispunjen gornji dio bazena. Prah se fluidizira
(suspendira). Iznad bazena je postavljen usisni uredaj povezan s filtrom za regeneraciju. Sustav
usisava prah koji se uskovitla tijekom oblaganja, proc¢is¢ava ga i kroz injektor s crijevom vraca
nazad u bazen. Razina praha u bazenu se regulira uz pomo¢ detektora. U slucaju pada razine,
spremnik se dopunjava preko stanice za doziranje svjezeg praha do postizanja Zeljene razine.

Postrojenje je opremljeno s dva usisna filtra. Za prah standardne boje (plava RAL 5015) je
osiguran odvojeni filtar s automatskim povratom praha. Drugi filtar se koristi za prah drugih
boja. Zbog neupotrebljivosti mjesavine praha razlicitih boja, isti nije povezan s regeneracijskim

sustavom [14].

Slika 2.14 Bazen za fluidizaciju praha [13]

Nakon plastifikacije, proizvodi se hlade prolaskom kroz rashladni tunel. Odljevci se
smjestaju na pokretnu traku. Zona hladenja je opremljena s 8 aksijalnih ventilatora i ispusnim
ventilatorom. Kroz aksijalne ventilatore se upuhuje zrak koji hladi odljevke. Ispusni ventilator,
pri¢vricen na stropu rashladnog tunela, usisava zrak iz tunela i upuhuje ga u otvoreni prostor, ili
ga upuhuje u susjedni odjel proizvodnog prostora. Usisani zrak struji iz prostorije kroz dva kraja

rashladnoga tunela.
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Slika 2.15 Rashladni tunel [13]

Nakon §to su proizvodi prosli kroz zonu hladenja, proces plastifikacije je zavrSen. OStecenja

prevlake na mjestima prihvata steznih naprava trebaju biti popravljena.

Slika 2.16 Ostecéenje od prihvata [13]
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2.3. Bitumenizacija

Pojavom plastifikacije u industrijama sve manje se Koristi zaStita Zeljeza bitumenom.
Zeljezne cijevi za kanalizaciju, vodovod ili plinovod, koje se upotrebljavaju za izgradnju
podzemnih cjevovoda i spremnika, zasticuju se od korozije prevlacenjem bitumenom ili
katranom. Cijevi se uranjaju u rastaljeni bitumen i zagrijavaju na temperaturu oko 300°C.

Materijal za premaze mora se sastojati od bitumenskog materijala ili od sinteticke smole.
Odgovaraju¢i dodaci (otapala, anorganske ispune itd.) su dozvoljeni da bi se postiglo lako
nanosenje i susenje. Prije nanoSenja povrSina mora biti suha, bez hrde ili slobodnih dijeli¢a, te
bez ulja ili masti. Premaz mora cijelu povrSinu jednoliko prikriti, mora biti gladak i homogen.
Mora se dobro osusiti da se komadi ne bi medusobno slijepili. Premaz se nanaSa uranjanjem,

Spricanjem ili kistom [3].

Slika 2.17 Bitumenizirani podzemni hidrant [15]

2.3.1 Linija za bitumeniziranje vodenim postupkom (uranjanjem)

Nakon sa¢marenja do zadovoljavajuce cisto¢e povrSine, radni komadi se stavljaju na
transporter — transportni lanac i ulaze u tunel na predgrijavanje. Tunel za predgrijavanje je
istovremeno i tunel za suSenje, ima ugradenu opremu za odsis i dobavu zraka. Zagrijavaju se na
potrebnu temperaturu i dovode se do mjesta za uranjanje. Za nadoknadu odsisanog zraka te
zagrijavanje koristi se plinski zagrija¢ zraka koji omogucuje potrebnu temperaturu
predgrijavanja, odnosno suSenja. Za regulaciju temperature u tunelu koristi se termometar.
Upravljanje procesom rada u tunelu (nadtlak/potlak, kontrola ventilacije, kontrola temperature,

kontrola zapunjenosti filtra, i sl.) je preko elektrokomandnog ormara upravljanog PLC-om [15].
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Predgrijani radni komadi uranjaju se u spremnik s bojom u vremenu koje je potrebno da boja
prione na samu povrSinu. Isto se vr$i na nacin da kada sa bojom putem hidraulickog stola slijedi
takt lanca i dize se gore dolje, dok komadi miruju na lancu. Na spremniku za uranjanje
montirana je membranska pumpa i sistem cirkuliranja same boje. Isto je potrebno da se
onemoguci taloZzenje boje koja je na vodenoj osnovi i slabo je dispergirana.

ZavrSetkom procesa uranjanja radni komad se pomice zajedno sa lancem do kade za
cijedenje. Na komadu je boje u nanosu cca 40 — 60 microna. Nakon cijedenja radnog komada isti
se pomic¢e do radnog mjesta popravka nedostataka. ZavrSetkom popravaka radni komad se
pomice u tunel za odzraCivanje. Tunel za odzraCivanje ima ugradenu zasebnu opremu za odsis
zraka, dok se za nadoknadu zraka koristi termogen koji se ujedno koristi i za tunel za
susenje/predgrijavanje. Radni komad se ponovo predgrijava i ponovo potapa u boju. Sada na sebi
ima boje u debljini 80 — 120 microna koliki je i zahtijev standarda. Ponovo slijedi tunel za
odzrac¢ivanje u kojem se naglo odsisava zrak kako bi ve¢ina vode isparila prije tunela za suSenje.

Komadi se skidaju s transportne trake — lanca i odlazu u spremiste (postojec¢a gradevina) na
min 24 do 78 sati kako bi boja do kraja polimerizirala i kako se ne bi skidala (vrijeme

minimalnog stajanja ovisi o vanjskoj temperaturi i vlazi) [15].

Slika 2.18 Linija za bitumenizaciju uranjanjem [15]
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3. Programski alat V-REP

V-REP (eng. Virtual Robot Experimentation Platform) od $vicarske tvrtke Coppelia Robotics
je virtualna platforma za razvoj, simulaciju i testiranje robota i rjeSenja vezanih uz robotiku i
automatizaciju. S bogatom funkcionalnosti, dobrim grafickim suceljem i Sirokim API- jem

(Sucelje za programiranje aplikacija), V-REP je mozda i najnapredniji simulator takve vrste.

Alat V-REP ima otvoreni kod pa stoga postoje dvije vrste licenci:

- Komercijalna licenca
- Besplatna edukacijska licenca — namijenjena je za hobiste, studente, profesore, fakultete,
ucenike i Skole [16, 18].

Slika 2.19 Edukacijska verzija V-REP [16]

Neke od znacdajke V-REP-a su:

Podrska vise operacijskih sustava (Windows, Linux)

- ViSe programskih pristupa (pluginovi, udaljeni API klijenti, embedded skripte, dodaci,
ROS ¢vorovi)

- Vrlo bogat API (obi¢ni i1 udaljeni) s bibliotekama za vise jezika (C/C++, Lua, Python,
Java, Matlab...).

- Simulacija senzora blizine i vida.

- Vizualizacija i snimanje podataka. Moguca vizualizacija viSe simulacijskih izvedbi
istovremeno za vizualnu usporedbu.

- Detekcija kolizija, raCunanje minimalne udaljenosti, sustav za prikaz dinamickih Cestica.

- Modularnost emulatora fizike (eng. physics engines) ukljucuju¢i Bullet, ODE, Vortex.

- Planiranje puta i pokreta [16].

Unutar V-REP-a koristi se Lua programski jezik, ali omoguceno je povezivanje i s vanjskim
aplikacijama koje koriste druge programske jezike, kao S$to su C++, Java, Python, Matlab,
Octave i Urbi, a takoder je omoguéeno i sucelje prema ROS-u (Robot Operating System). Sve
navedeno ¢ini V-REP vrlo mo¢nim alatom za brzi razvoj i testiranje rjeSenja vezanih uz robotiku

i automatizaciju [17].
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V-REP je vrlo prilagodljiv simulator: gotovo svaki korak simulacije definira korisnik. Ova
fleksibilnost dopustena je putem integriranog tumaca skripti. V-REP proSiruje naredbe Lua i
dodaje V-REPu specifi¢ne naredbe koje se mogu prepoznati po njihovim sim-prefiksima (npr.
Sim.handleCollision) [16].

Postoji 6 razli¢itih pristupa za programiranje/ kontrolu modela:
1. Ugradena skripta (eng. Embedded script) — koristi se programski jezik Lua
2. Dodatak (eng. Add-on)
3. Prikljucak (eng. Plugin)
4. Udaljeni API (eng. Remote API)
5. ROS (eng. Robot Operating System)
6. Prilagodeni klijent/posluzitelj (eng. Custom Client/Server)

U alatu su odmah dostupni ve¢ razvijeni modeli nekih poznatih robota (Kuka YouBot) i
robotskih ruka (pojedini Jaco, ABB, KUKA...) koji su zamisljeni ili stvarni. Na scenu je moguce
dodavati modele robota, strojeva, ljudi te puno druge opreme koja je razvrstana po direktorijima

preglednika modela [18].
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Slika 2.20 Modeli robotskih ruka u V-REP [16]
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3.1. Robot KUKA

KUKA Roboter je njemacka tvrtka poznata u svijetu kao jedan od najvecih proizvodaca
industrijskih robota, koji se koriste u proizvodnji, paletiranju, rukovanju materijalom,
automatizaciji utovara, tockastom i elektrolu¢nom zavarivanju i mnogim drugim podruc¢jima.

Automobilska industrija je njihov primarni klijent, ali oni automatizacijskim proizvodima
opskrbljuju i svemirsku industriju. KUKA roboti koriste se u brojnim velikim kompanijama,
najviSe u industriji automobila, ali i u drugim industrijama, kao $to su svemirska industrija,
prijevoz, proizvodnja hrane i pi¢a, ljevaonice i kovnice, proizvodnja stakla, obrada drva, obrada

metala i industrija obrade kamena [19].

Slika 2.21 Model robotske ruke KUKA KR16 u V-REPu [16]

Odabrani model robota je Kuka- KR16 koji je prethodno uvezen u programski alat V-REP.
Robot srednjeg kapaciteta s CNC KUKA upravljanjem prikladan je za radove bojanja, mjerenja
ili montiranja te moZe raditi s teretom mase do najvise 35 kg [19].

Precizni, brzi pokreta¢ KR 16 ima nosivost od 16 kg i maksimalni domet od 1611 mm. Odli¢no
rjeSenje za raznoliku primjenu, KR 16 lako se prilagodava. Izraden od lagane legure, dizajn KR

16 pruza snagu i fleksibilnost.
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Njegova kompaktna struktura omogucéuje ugradnju na pod, strop i zid. Zasti¢eni zglobovi daju
KR 16 ¢istu i modernu izvedbu. Jednostavan za instalaciju i pokretanje, KR 16 nudi vrhunske
performanse u bilo kojem procesu - od rukovanja materijalom do zavarivanja, rezanja ili
lakiranja. KR 16 moze koristiti bilo KR C2 ili KR C4 regulator [20].

Os Brzina kretanja Granica kretanja
Al | 156 °/s(2.72 rad/s) +185°

A2 | 156°/s(2.72 rad/s) +35° - 155°
A3 | 156 °/s (2.72 rad/s) +154° - 130°

A4 | 330 °/s (5.76 rad/s) +350°
A5 | 330 °/s (5.76 rad/s) +130°
A6 | 615 °/s(10.73 rad/s) +350°

Slika 2.22 Smjer vrtnje osi robota [21]

2026
1320

1027 530 1081 S

Slika 2.23 Radni prostor robota KUKA KR-16 [21]
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Svi KUKA roboti rade uz CNC upravljacki sustav kojeg je moguce slobodno programirati.
KR C4 compact najnovija je i najnaprednija upravljacka jedinica iz Kukinog asortimana.
Omogucava visoke performanse i veliku pouzdanost u kompaktnome dizajnu. Fleksibilna
konfiguracija i moguc¢nost dodatnog prosirivanja (programskog ili implementacijom dodatnih osi
i pomoc¢nih elemenata) koju ova upravljacka jedinica nudi, daju joj velike moguc¢nosti razlicitih
primjena. Broj hardvera, elektricnih kablova i konektora znacajno je smanjen i zamijenjen
programskim rjesenjima. Robusne i kvalitetne izrade, ova upravljacka jedinica ne zahtjeva veliko
odrzavanje, a rashladni sustav se ukljucuje samo po potrebi i gotovo je necujan. Zahvaljujuci
otvorenoj arhitekturi, KR C4 compact osim robota moze kontrolirati i upravljati dodatnim
vanjskim osima (linearna traka, rotacijski stol i sl.). Osim standardnog KUKA programskog
jezika (KRL), KR C4 moze ¢itati i izvrSavati naredbe pisane u standardnom CNC programskom

jeziku (G kod), te u jezicima za programiranje PLC-a [22, 23].

1 Manipulator 3 Upravljacka jedinica KR C4 compact
2 Spojeni kablovi 4 Upravljacko sucelje SmartPAD

Slika 2.24 Primjer robotskog sustava [21]

Sa svojim velikim ekranom osjetljivim na dodir, upravljacko sucelje KUKA SmartPAD
omogucava upravljanje i kontrolu nad robotom i nad cjelokupnim sustavom, koji moze biti
prikazan na ekranu. Sucelje se samostalno prilagodava na nacin da korisniku prikazuje samo one
informacije, i omogucava samo one naredbe koje su u danome trenutku potrebne za potpunu
kontrolu nad sustavom. Naglasak je uvijek na onome $to je bitno, tako da je rad puno intuitivniji,
brzi, laksi i uéinkovitiji [22, 23].
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3.2. Model stalka

Model koji ¢e posluziti za prikaz bojanja u V-REPU je stalak ,,Viktorija zdenca“ koji sluzi za
uzimanje pitke vode iz vodovodne mreze. Ugraduje se na ulicama, kolodvorima, sportskim
terenima, tvornicama, Skolama, naseljima itd. Osiguran je protiv smrzavanja i zagadivanja,

jednostavan za rukovanje. Priklju¢ak na vodovodnu mrezu izveden je sa G 1/2.

Slika 2.25 Viktorija zdenac

Iz SolidEdge-a pretvara se u datoteku 3D objekta (.stl) zatim se objekt ubacuje u V-REP.

Slika 2.26 Stalak u SolidEdge-u i V-REP-u
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3.3. Virtualna stvarnost

Virtualna stvarnost (engleski Virtual Reality - VR) je ra¢unalno stvoreno sucelje koje imitira
stvarnost, odnosno zbilju i omogucéuje interakciju ¢ovjeka u tom imitiranom svijetu. Na taj nacin
simulira se virtualno okruzenje u kojem djeluje korisnik. Ivan Sutherland, jedan od
najznacajnijih istrazivaca u podruc¢ju virtualne stvarnosti, 1965. godine iznosi zamisao kako ,.taj
(virtualni) svijet treba izgledati stvarno, zvucati stvarno, imati osjecaj stvarnosti i realisticno

odgovarati na djelovanje korisnika“ [24].

Slika 2.27 Virtualni koncept iz 1965. godine [25]

Vazan koncept koji predstavlja VR je sustav predoCavanja, koji se odnosi na osjecaj potpune
uronjenosti u trodimenzijskom racunalno generiranom okruzenju, pomocu koje se iz korisnicke
perspektive uvelike olakSava. Glavna prednost koriStenja virtualne stvarnosti ocituje se kao
moguénost stvaranja i simuliranja novih tehnoloskih jedinica prije njihove realizacije. Ovo mozZe
doprinijeti povecanju sigurnosti, ergonomije i smanjenju troSkova. Virtualni model radnog
mjesta mogao bi otkriti skrivene pogreske koje se eliminiraju, a koje bi u kasnijoj fazi na tom
radnom mjestu mogle uzrokovati velike poteskoce [26].

Virtualna stvarnost uvodi se zbog smanjenja troSkova razvoja kod pojedinih procesa,
povecanja produktivnosti, lakSeg rukovanja dijelovima ali i prvenstveno zbog razli¢itih
mogucnosti koje pruza, a koje su sve donedavno bile nezamislive. Tipi¢ni strojarski primjeri

mogu se naci u podrucju robotike, razvoja proizvoda i virtualnog sklapanja.
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Primjena virtualne stvarnosti uranja korisnika u ra¢unalno generiranu okolinu koja simulira
stvarnost kroz upotrebu interaktivnih uredaja koji Salju i primaju informacije i nose se kao

naocale, slusalice, rukavice ili odijela.

Slika 2.28 HTC Vive VR set [25]

Danas razvijenost tehnologije omogucuje da virtualna stvarnost ima sve Siru primjenu, pa se
ona susrece u poljima poput medicine, strojarstva, robotike, raznim granama industrije, ali i u
podrucju zabave, gdje omogucuje upoznavanje i sudjelovanje vrlo Siroke populacije.

Ona se primjerice koristi vrlo ¢esto u obuci za novi posao ili u prezentiranju nekog koncepta
ili iskustva publici. Brojna su podruéja koja koriste virtualnu realnost i na¢ina na koji je uklapaju
u svakodnevni zivot, a to su zabava, automobilska industrija, marketing, obrazovanje, svemirska
istrazivanja te sve viSe u obucavanju vojske i policije. Privla¢nost simulacija je $to one mogu
pruziti obuku jednaku ili gotovo jednaku praksama sa stvarnim sustavima, ali o manjem

financijskom trosku i s ve¢om razinom sigurnosti [27].

Slika 2.29 Primjer primjene u industriji [28]
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Virtualna stvarnost u strojarstvu ukljucuje upotrebu 3D alata za modeliranje i vizualizacijske
tehnike kao dio dizajnerskog procesa. Tehnologija omogucava inzenjerima da pregledaju svoj
projekt u 3D, te da steknu bolje razumijevanje kako taj objekt radi. Jo$ jedna prednost je da se
svaka mana ili potencijalni rizik moze uoditi prije same proizvodnje i implementacije (Virtual
Reality in Engineering, url). Samim time i dizajnerski tim moZe promatrati svoj projekt u
sigurnoj okolini i raditi promjene tamo gdje su potrebne.

Proizvodaci automobila ovu tehnologiju koriste tijekom crtanja i kreiranja prototipova. To im
omogucava da proizvedu nekoliko verzija prototipova te da ih mijenjaju sukladno dobivenim
rezultatima iz testova. Jo§ jedna prednost je da se ne mora raditi fizi¢ki prototip te se upravo time
Stedi na vremenu i novcu (Virtual Reality in Engineering, url). Vaznost virtualne stvarnosti je

njezina sposobnost prikazivanja najmanjih detalja u projektu kako bi se odrzala iluzija stvarnosti.

Za to su potrebna vrlo snazna racunala, video sa visokom brzinom osvjeZavanja slike 1 realisti¢ni

zvuk i fizika tijela [24].

Slika 2.30 3D modeliranje pomocu virtualne stvarnosti [29]
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Neke od glavnih prednosti implementacije VR-a na 3D projektiranja:

1. Pregled, analiza i validacija sklopa ili cijelog proizvoda

VR omogucava projektantima, dizajnerima, prodajnim i marketing osobama,
kupcima, da pomocu virtualnog modela proizvoda pregledaju i analiziraju proizvod u
kontekstu validacije konstrukcije 1 dizajna, montaze i1 demontaze, provjere

ergonomije, provjere vizualnih karakteristika, ponasanja proizvoda itd.

2. Unaprijedenje metode edukacije

Tvrtke mogu unaprijedivati metodologiju edukacije zaposlenika prije finaliziranja
proizvodnje i izrade prototipa, kao i nakon izrade proizvoda i njegove eksploatacije.
Zaposleni mogu steéi realan osjecaj kako ¢e proizvod izgledati i mogu efikasno

pripremiti komunikaciju s potencijalnim kupcima i educirati trziste.

3. Rano otkrivanje nedostataka

Kako bi se izbjegli eventualni nedostaci u procesu projektiranja i omogucéio redizajn
prije finalizacije, VR pomaze inZenjerima identifikaciju potencijalnih problema i
uklanjanje nepravilnosti. Radi se o izrazito korisnoj funkcionalnosti jer se

prevencijom greSaka maksimalno smanjuju nepotrebni tro§kovi.

4. Simulacija stvarnih situacija

InZenjeri mogu gotovo fizi€ki zakoraciti u svoj projektirani prostor i realnije iskusiti

dijelove ili cijeli proizvod te uociti nepravilnosti na vrijeme.

5. PoboljSana komunikacija 1 odsluskivanije trzista

Odobrenja u procesu projektiranja, na koja se ¢esto dugo ¢eka i zbog kojih proizvodni
ciklus moze kasniti, se znatno brze provode. Projektanti i kupci, odnosno narucitelji
posla, mogu s razliCitih lokacija pristupati istom virtualnom svijetu. To znatno
olakSava komunikaciju, razumijevanje i instrukcije vezano za naknadne izmjene, a

sve to u realnom vremenu i prije zavr$ne narudzbe. [29]
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Automobilska industrija

Kompanija Ford ve¢ koristi virtualnu realnost u svom laboratoriju za uzivljavanje kako bi
pruzila osjecaj koji ima kupac u svom novom automobilu. Pritom koristi uredaj Oculus Rift kako
bi osobi omogucila pogled na interijer i eksterijer automobila. Takoder je razvila alate koji ¢e biti
koriSteni u VR iskustvu razgledavanja automobila u mraku. To je vrlo korisno jer Ford moZe
brze raditi na razvoju proizvoda bez ¢ekanja na fizicki prototip novog modela.

I Audi ¢e koristiti virtualnu realnost kako bi potencijalnim kupcima automobila pruzio
dubinski pogled na automobile.

Toyota je Koristila virtualnu realnost u sklopu svoje kampanje TeenDrive365 kako bi
educirala tinejdzere i roditelje o dekoncentraciji u voznji. Simulator demokoncentracije u voznji
ukljucuje senzore koji prevode ono S$to korisnik ¢ini s pedalama ili volanom u simulaciju, te

ukljuéuje odvlacenje paznje poput zvonjave mobitela [30].

Slika 2.32 Upravijanje robotskom rukom pomocéu VR u V-REPu [29]
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4. lzrada programa za bojanje robotom u alatu V-REP

Zbog $to manjeg izlaganja ljudi na teSke uvjete rada, opasnosti u blizini zapaljivih tvari i
otrovnim supstancama iz boja i lakova dolazi do potrebe automatizirane proizvodnje. Klasi¢no
bojanje rasprSivaem zamjenjuje Se robotom koji se precizno programira tako da oponasa
ljudsku ruku. Preciznim programiranjem pokreta robotske ruke moze se povecati kvaliteta
premaza, potrebna debljina premaza i brzina lakiranja radnih komada. Koli¢ina i narudzbe od
strane kupaca su naravno za veliko serijsku proizvodnju, jer za male pojedinacne koli¢ine ne bi
bilo isplativo automatizirati proizvodnju.

U projektu ¢e se prikazati automatizirano postrojenje za lakiranje radnih komada pomocu
robotske ruke. Radni komadi vjeSaju se na transporter, te ulaze u sa¢maru gdje se Ciste do
zadovoljavajuce Cisto¢e povrsine. Preko vodilica radni komad dolazi do pozicije gdje pozicioner
okre¢e radni komad dok istovremeno robotska ruka nanosi slojeve premaza ovisno o debljini
sloja koji je potrebni. Kretnje robota i linije su tehnoloski razradene prije nego se pristupi samoj
realizaciji posla. Kod pozicije zaustavljanja radnog komada istovremeno i radni prostor robota,
nalazi se filter za usisivanje Stetnih supstanci iz boja i prikupljanje Cestica viska boje koje se
prilikom rasprSivanja prenesu izvan radnoga komada. Nakon §to se program bojanja zavrsi
obojani komadi se transportiraju po vodilici do zagrijane suSare koja je opremljena sa
ventilatorima koji upuhuju topli zrak za brzo suSenje komada. Izlaskom iz susare radni komadi
se premjestaju u spremiste u kojem moraju komadi stajati ovisno o temperaturi i vlazi minimalno
24 sata kako bi se boja Sto bolje polimerizirala.

Postrojenje za lakiranje robotom prikazati ¢e se u programskome alatu V-REP.

Slika 4.1 Robotska céelija u V-REPu
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4.1 Pokretanje programskog alata V- REP

Programski alat V- REP PRO EDU je besplatni edukativni alat za sve studente, profesore i

hobiste.

V-REP PRO
ECL

Slika 4.2 lkona za pokretanje programskog alata V-REP

Dvoklikom na ikonu V-REP PRO EDU otvara se zaslon programa ujedno i nova scena. U
zaslonu se nalazi pod na koji se ubacuju modeli, stablo koje prikazuje povezanost i pretraziva¢
ve¢ gotovih modela. Ostale funkcije promjene polozaja modela, prikaz simulacije, izrada putanje

itd. nalaze se takoder unutar zaslona programa.

3 V-REP PRO EDU - New file - rendering: 6 ms (7.9 fps) - SIMULATION STOPPED
File Edit Add Simulaton Tools Plugins Add-ons Scenes Help

c%: L 3 @ :ﬁ’o: %‘aa:m @N i) ) © Bulet2.78 ~ | Acarate (efou) ~ [at=somseraiy < | >[Il [] & e 2 4§ s | f R
.

new scene
Scene hierarchy X ESeleded objects:
[l

@ newscene (scene 1) = Il
B o- @ ResizableFloor 5.25 (&

@o- @ Defaulligh
mo- @ xv7e :

Simulator launched, welcome!
(for quick customizations, edit the sandbox script system/sndbxsct. txd)

| sandbox script

ABB IRB 140.ttm S = = .
here, or type "help()" (use TABR for auto-completion)

~||[Input Lua code

Slika 4.3 Zaslon i nova scena programskog alata V-REP
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4.2 Dodavanje robota KUKA KR-16

U pretrazivacu modela postoje dvije vrste modela robota mobilni ili pokretni roboti i
nepokretni roboti tj. oni koji se ne kre¢u cijelim tijelom, odnosno ne mijenjaju polozaj u nekom
prostoru, ve¢inom industrijske ruke.

Odabrani je model robota KUKA KR-16, te se lijevim klikom miSa prenese u prozor scene.

3} V-REP PRO EDU - New file - rendering: 14 ms (7.9 fps) - SIMULATION STOPPED = X
File Edit Add Simulation Tools Plugins Add-ons Scenes Help
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[ household Ho-@ R 525 @ Last selected object orientation: a:+000.00 h:-090.00 g:+000.00
Em ¥ [ infrastructure Ho & D
[ nature 3
Eo- @ XYZCameraProx
- E oy e 56 @ KUKA ROBOT 1IW
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=] forear re
& forearm_twisting_vie
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B @ wrist_respondabld
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a axis
KUKA KR-16.ttm & axisb_visue
J ) Model loaded.
Executing undo...
' oy
J
2 +||Input Lua code here, or type "help()" (use TAB for auto-completion) | sandbox script v | ®

VLA L B0 fiin 140990 tbm

Slika 4.4 Odabir robota i stavljanje u scenu

Klikom na ikonicu | = ,Object/Item Shift“ moZe se pomicati robot po X, Y, Z osi.

3 V-REP PRO EDU - New file - rendering: 38 ms (164 fps) - SIMULATION STOPPED - X
File Edit Add Simulaton Tools Plugins Add-ons Scenes Help bject/Item Translation/Position
2 = ‘ 5 = & ]
c}% i % o6 (0° | T 2 Y 2 O lauetzzm ~ a S B 4 W lflg - &
% 1@ EEES (=Y 4 === 1= | MouseTransation | positon | Transiaton | Pos. Scaing ? L e
Model browser rew e
"B oo Relaveto:  ® Word () Parentframe () Own frame
B oot Scene hierarchy [ Selected ob
& B conpies @ new scene (scene 1) (/[ ﬂtﬁ‘ z:::gg Trandatonstepsize (il [Defmit - ) DefaultNZViewCamera =
Q 7 [ fumiture b4 Lastselacts | Preferredaxes: [vialongX V] along Y along 12126 [y
[ household Ho- & Lastselecte ElEEEEEEE ]
¥ [ infrastructure Ho- & Once the mouse button is down, use the ctri-key for orthogonal |
J} lxﬂ [ nature 5 T directions. Use the shift-key for smaller step sizes.
| | offcetems ESSeb piesne s
@ | |- 6 other B0 (& KUKA ROBOT ] Il

& base_link_visual

o & fo R
B @ forearm_twisting_resp
& forearm_twisting_vis
a e
& wrist_visusl
B & ox
8 Q ax
KUKA KR-16.ttm
; Model loaded.
Executing undo...
' e
e i LT :_‘_ <i{|Input Lua code here, or type "help()" (use TAB for auto-completion) | sandbox script | ®

Slika 4.5 Pomicanje i promjena poloZaja robota po koordinatnim osima
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4.2.1 Postavljanje inverzne kinematike robota

Na svaki udruzeni spoj modela od kojih se sastoji robot potrebno je postaviti nacin u
inverznu kinematiku, koja pronalazi poloZaje i kuteve svih segmenata i zglobova, tako da
manipulator bude u Zeljenoj krajnjoj tocki. Lijevim dvoklikom na ,,Joint* otvara se prozor u

kojem se promijeni nacin ( Mode—> Inverse kinematics mode).

3
: ¢ & &
c{'r-o 4% 3 @ :"o: % oo @% & ) ™ Bulet2.78 ~ | Acaxste (defout) ~ |dtaSOms(defadt) ~ | [> @ o & &f O
tutortial
Scene hierarchy xljfﬂemdobﬁn& 1 et
T - =
r Mé:ld doroman : osit Wn(sos 4’2‘6’104””03590
x d 2 +0.
B a L & +0000058 b +000036. g -047.71
ol 5
Jo @
°@® Scene Object Properties - |
&) base_link_visual
& rotary_head Jont Common
& rotary_head_visusl Configuration
Position Is cydc Screw pitch [mideg]  +0.00¢ 400
Pos.min. [deg)  -1.800e+02 | Pos.range [deg) 3.600e402
& lower_arm_visual Postion [deg]  40.000e400
X caladaton weght 1.00
i @ Max. stepaze [deg]  1.00e401
< & upper_arm_visuel
.H} o \& ng ‘ Aoy to seectn
iz N B forearm_twisting_vie
1 ¢ Hybrid operaton
g \) < Adpust dependen ,
@ ‘/ 3 wrist_visuel
b 700F manipulatoe. ttm : 0 Apply 1o zelection
&ﬂ' & edsb_visue
Length [m] 0.1 Adpust color A
Diameter [m] 0.020 Adyst color 8
Model loaded. Acply 1o selection
Deletng selecton. . L
e S—— Show dynamic properties dialog L. @
AR <||Input Lua code here r type "ha ? e —=

Slika 4.6 Postavljanje u nacin inverzne kinematike

Ubacivanje objekta ili tocke s orijentacijom ,,Dummy* (Menu bar - Add-> Dummy) koji su
viSenamjenski ili pomo¢ni predmeti, te se koriste u kombinaciji s drugim objektom ili modulima
za prorac¢un minimalne udaljenosti od drugog objekta da ne dode do sudara. Preimenuje se u
,tip®, oznadi se tip i axis6_visual, zatim se klikne (Menu bar > Edit-> Make last selected object
parent), te se spaja sa nadredenim objektom na zadnjoj osi robota

[T —
R DefeufiCamera Last selected object posiion

x
& fp Last selected ohject arientation =-0¢
mo- & ResizableFloor 5 75 (8
me- @ DefauliLights - ¢

@He- & XvZCameraProxy

Ze- @ KUkAROBOT Bet 278 + | Acarote (Gefot) ~ | dtesoms ooty ~ | [> (=S w &y &
M base_link_visual
I B & rotary_head
B @ rotary_head_respondable % J= Selected objects: 1
M rotary_head_visual %|Last selectad objectname:
B & lower_aim X 03661 {-o.me 2410995
B @ lowsr_arm_respondable @:-000.00 b:+000.00 g:-000.00
& lower_arm_visual Mouse Translation | Poston | Transaton  Pos. Scang
BT & upper am Relotve to: Wodd © Parent fame
B @ upper_ami_respondable
&) upper_arm_visual X<oord. [m] | +0.0000e+00 | | Apply X to zek =
B & forearm_twisting Y<oord. [m]  |+0.00006400 | | Aocly ¥ to sed ko
B & forearm_twisting_respondable Z<oord. [m])  |40.00006400 | | Apply Z to sel
&) foream_twisting_visual i
B & wirist Make selected object(s)
wrist_visual Marsh selcton nto 15 . .
B & oieh jorph selection inta its convex decomposition. ..
5] O axisb_respondable Decimate selected shape.
axis . i
&® Expand ol
Copy selected objects
Collapse ol
Paste buffer
Expand selected trees
Delete selected objects
Smulation stopped Collapse selected trees

Adding a dummy... Cut selected objects

Slika 4.7 Spajanje i pozicioniranje Dummy ,,tip “sa zadnjom osi robota
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Zatim se ponovo ubacuje toc¢ka s orijentacijom ,,Dummy* (Menu bar - Add-> Dummy) ili

se kopira ,.tip“, te zaljepi i preimenuje u ,target”. , Target” je tocka na putanji koju ¢e slijediti u

polozaju i orijentaciji tocka ,,tip“ koja je povezana sa robotom, dakle tocka ,.tip* dovodi robot do

neke putanje na kojoj se nalazi tocka ,,target* koja putuje po njoj.

Nadalje mora se obavijestiti V-REP da su ,tip“ i ,target® par za inverznu rezoluciju

kinematike. Dvostrukim lijevim klikom na ,.tip“ otvara se prozor u kojem se povezu ,,tip* i

Htarget® (Linked dummy -> target), te se prikazu crvenom strelicom u stablu scene.

& torget 0-
&
o
3 rotary_head_visual

&

33 lower_arm_visual
&

xn

¥ upper_arm_visual

3¢
¥) forearm_twisting_visual

®»
¥ wrist_visual
&
v
& axish_visual
<, Force_sensor
o P
¥ PaintNozzleBody
“ PaintNozzleJetVolume

& vp

Scene Object Properties

Dummy Common

Oummy - dummy linking
Unked dummy
LUk type

=

IX, tp-target -

Trajectory
Follow parent path orsentation (only indrect parent)
Folow parent path (only drect parent)

Distance offsets
Offset [=] Copy inc. fm]
Visual properties
Objectsize [m] 00100 Adjust dummy color

B e

Slika 4.8 Spajanje Dummy ,,tip* i , target”

Otvaranje racunskih modula za proracun koji omoguéavaju rjesavanje na vrlo uc¢inkovit na¢in

bilo koje vrste inverznog kinematickog problema

(Calculation modules=> Kinematics=> Add new IK group-> Edit IK elements—> odabere se

,tip“ 1 Add new IK elements with tip—> izabire se da ¢e baza biti KUKA_ROBOT-> koordinate

prema ,target®).

Colision Distance Kinematics Dynamics

| K groups enabled

J‘/’F“ﬁﬂ Add new IK group

IK_Group [containing 1 ik element(s)]

V| IK group is active
Explicit handing
V| Mechanism is redundant | Ignore max. step sizes
Calc. method DLS ~ | Damping |0.1000
Max. iterations 3
Caleuiation weights Joint limit thresholds
Joint imits 1.00 Linear [m]  [0.001

Obstadle avoidance |1.00 Angular [deg] |2.00

Various

Edit conditional parameters
Edit obstacle avoidance parameters

Edit K elements

1K Group (IK_Group) B
IK elements
Add new IK element with tip: DefaultLights A

V| Element is active

Kinematic chain

Base KUKA_ROBOT -
Target  target

Constraints
v X v Y vz v Apha-beta ¥V Gamma
Relative to coordinate frame | target v

Desired precisions Resolution weights

Linear [m] 5.00e-04

Angular [deg]  |1.00e-01

Linear 1.00
Angular 1.00

Slika 4.9 Postavijanje kinematickih racunskih modula
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Povratkom u prozor Calculation Modules ukljuci se kvacica Mechanism is redundant, te
odabire da se primjene zajednicke korekcije krajnjih granica tijekom IK rezolucije, a u
suprotnom ako se provode nakon moze dovesti do nestabilnosti.

Calc. method- metoda izratuna koja se koristi za specificiranu razlucivost IK grupe
odabiremo DLS jer je sporiji, ali stabilniji kada meta i vrh leze predaleko, kad je kinematicki
lanac preopterecen ili kad je mehanizam u blizini pojedinac¢ne konfiguracije.

Nakon S§to se postave racunski moduli, moze Se pozicionirati ,target” da bude vidljiv i

udaljeniji od ,,tip*, te da se vidi linija kretanja od pocetnog polozaja do ciljnog.

(Object/item shift=> i pomice se po Z- osi)

i 2T (m]|Last selected object name: target
© utorial (s;ene ] - Last selected obﬁecnype: Dummy
Last selected object position: x +0.0250 y:-0.7250 z:+1.3500
arge! ast selected ohject orientation: 2 -000. : +000.00 g:-000.f

& target L lected ohyj i i 000.00 b:+000.00 000.00
Ho & Floor_5_25 £
Ho- & t
Ho &

o @
M hase_link_visual
=] a1 I:
Sl Y
M rotary_head visual

Py B & 111 Object/Item Translation/Position
B @ i
C’@D B lowe | Mouse Translation | Poston | Transiaon | Pos. Scaing
= PpE

B @& up | Relatveto:  (® world Parent frame Own frame
o £
a ‘} { Translation step size [m] 0.001 .2
G @ | Preferredaxes: [ alongX along Y V! along
! | Once the mouse button is down, use the ctrl-key for orthogonal
=] + | directions. Use the shift-key for smaller step sizes.
=]

B Q ax v
B (D axisb_visual

& tip

- & wrist_visual > il
B & o J - =

Slika 4.10 Pomicanje ciljne tocke ,,target **

Na kraju ,target* ozna¢i se klikom i prenese u podnivo stabla sklopa robota
KUKA_ROBOT.

Time je uspjesno postavljena inverzna kinematika robota, tako da je sad robot pod kontrolom

kretnje prilikom mijenjanja pozicije ,,target-a“.

Takoder prije sljede¢ih radnji i koraka mogu se isprobati prikazi kretnje i vidjeti da li je sve
dobro postavljeno u inverznoj kinematici robota, preko simulacije koja se otvara pritiskom na

tipku Start/Resume simulation.

>
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4.2.2 Postavljanje senzora i piStolja za boju

Prvo ¢e se pronac¢i model pistolja za boju (Model browser-> components—> modifiers—> paint

gun i prenese se U prozor sa scenom).

AL PN LUV SIG £0 UUJGHIE TULULUIIE - TEHUSHIY. © 1113 (W3 13) - SIVIVLATIVIN 21U F LU

rover
File Edit Add Simulaton Tools Plugins Add-ons Scenes Help

:{g"{% his @ :ﬁ’o: q‘aﬁ::n @% Zn &) Y CX O [puetzrs ~ | acarate @efot) ~ [at=somseraity ~ | > [I[] [] @ B ‘:,\\f 4 & ﬂ

> Model browser - * | celia za bojanje robotom |
[ component . : —
& |- B actuators SCEnE»hIEYﬂrEhy S x@Selsﬁad ohjects:
| [ grippers =]
Q | 1 locomotion and pr...
B ™ modifiers

E [ sensors
lx] £ [ equipment

|+ [ conveyor belts
BA [ panes
YO | = [ examples
[ block factory
@ [ furniture
=1 household
i [ infrastructure
[ nature

B 2D

& wrist_visual
B & axish
B Q axisb_respondahle
B @ axish_visual
@ tp ¢

Model loaded.
e Executing undo...
— done.

& @ 0

Slika 4.11 Prijenos pistolja za boju

0

Da bi se mogao postaviti pistolj za boju potrebno je postaviti senzor sile koji mjeri prenesene

sile i zakretne momente. (Add-> Force sensor)

Potom oznaci se Force sensor i axis6_respondable, te otvori Object position—> i klik na

Apply to selection. Tada se prenese senzor na istu poziciju na kojoj je vrh zadnjeg modela robota

Simulation Tools Plugins Add-ons

3 Last selecied object

Primitive shape v & Force_sensor Last selacted ub‘mg

) ne & a Last selectad objecto
Joint 3 o @ 5
Camera ° 9

ne &
Light » o - Ho & ;
Dummy Z=ean \\-\__ &) base_link_visual
Force_gdensorl ™ & tergel
Point doud B &
| B @&
Octree = | 3 rotary_he
Graph B & 1
Proximity sensor » 8 3“?‘ o | Mo Trasaton | Poston | Translaton | Pus. Sag
Vision sensor 3 : B & ¢ | Relative to: ® workd Parent frame
o X
Force sensor .}1’1 | | Xecoord ] +3.6510001 | | ApplyXtosel,
Path » 1 G & || Yoodinl 7.26801 | | AmiyYiosel | | BT
G @ | Z<oord.fm]  +1.0995¢+00 | | ApplyZtosel, | |
Assodiated child script b ! |
Assodiated customization script — 58 e ® . . ]
I e — =] !
Convex hull of selection = T et &) wmst_visual
. o g &

Inflated convex hull of selection... oo L T
Convex decomposition of selection... E 0 exish_visual

Slika 4.12 Dodavanije, izgled i pozicija senzora
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7

Senzor je potrebno okrenuti, te ¢e posluziti alat Object rotation. g
(Oznaci se Force sensor i axis6=> Object rotation—> Apply to selection).

% aéo &5\ '?r_r] ) Bulet278 ~ | Acurate (defoul) ~ |dt=soms@efout)  ~ | > [|[] [] @ & §
Celja za bojanje robotom
Scene hierarchy ><|§L ame-frame distance=0.03
ST : g 00000
Qe & ble L
G0 &
10 @
Go @
20 @ F

M base_link_visual
@ terget
&

Y ssnondable
&) rotary_he Object/tem Rotation/Orientation
5 ]

Mouse Rotation | Orientation | Rotation

B lowe
P | Relatveto:  (® Wodd Parent frame
d‘m“ Alpha [deg) -2.0103% 401
& | | oetaideal -3.5212e 401 Mo

S @0 | Gamma [deg] +3.8509e401

u
2l e
& wist_visual
O & exish

E

Slika 4.13 Okretanje senzora u polozaj osi

2+ A axisb visual

Slijedi spajanje senzora i pistolja za bojanje, kod kojeg ¢e pomo¢i alat Assemble. %H
(Oznaci se PaintNozzle i Force sensor-> Assemble).

P 1 : >
b|eBe @ |2&n ) @ O [autet278 ~ | Acarate (defout) ~ |dt=soms(@etat)  ~ | [> [|[ @ iy s iR &
Celga za bojanje robotom

Scene hierarchy
@ Celija za bojanje robotom (scene 1) -/ Ul

% I< Selected objects: 2 (frame-frame distance=0.0750)
uLast selecter Force_sensor
L Force_sensor
0.3651 X-OJZGS 2:+1.09%
10 b:-03521 g 0030,

L
L

Ho @ Fe
He & t
1 % Force_sensor
Eoe @ PaintNozzle ™| [l
He & .
do @& E
B base_link_visual
& torget
e &
a8
&) rotary_head_visual
&

Slika 4.14 Sastavljanje senzora i pistolja za boju

Doslo je do problema da se pistolj za boju spojio sa senzorom u krivu stranu, rjesenje je da se

(oznaci ponovo Force sensor i PaintNozzle—> Object orientation—> Apply to selection).

r!a%o @{ B b Y O O [nderarm - [acarate (et - [a=somermy - | D> [ [ @ @ 53 4 @ & R
Celia za bojanje robotom |
Scene hierarchy X Ef:bﬁsld Dbidel:»si 'Zagrume-frlums distance=0.0750)
jia 2 bojan = H|Last selected c intNozzle
[+ Ceg'ﬂ z o (scene 1) f| I Last selected Shape (simple, pure (oﬁinde?)
Last selected ob) x +0.4083 v:-0.7845 z:+1.0786
Ho- & L | of a-070.10 b:-03521 g:+038.51
Ho- & De )

2 & Force_sensor
@o i (=0
® K
& base_link_visual
& targ ¢
B & rotar

rotary_head_respondal
M) rotary_head_visual

Object/Item Rotation/Orientation

Mouse Rotation | Orientation | Rotation

Relative to: ) world ) Parent frame
Alpha [deg] |-7.0105e+01 |
Beta [deg] [-3.5213e401 | ;‘gg‘g{,:‘,’,
Gamma [deg] |+3.8508e+01 |

8 wrist_visual

B & axish

B @ exisb_respondable
B @ exisb_visual

Slika 4.15 Okretanje pistolja za boju u ispravau stranu
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4.3 Ubacivanje modela iz Solid Edge-a u V-REP

Model stalka koji je izmodeliran u programu Solid Edge, potrebno je prvo pretvoriti u 3D

model u STL dokument kojeg se moze uvesti u V-REP.

U Solid Edge- u klikom na (Application button-> Save as—> Save as Translated—> Save as

EL}?\;‘J L

Solid Edge ST8 - Ordered Part - [VZ-4_Stalak ver 3.par]

Home Surfacing PMI Simulation Inspect Tools View
& R @ D QB @@ @ ~ [ Color Manager 44 Styles
e 38 g G‘ @ v i ‘4V|ew Overrides
1] set  on | [Hlke ﬁ E < Sketch | Zoom m
Planes View Area r ‘r gPan Painter
Show Clip Views Orient Style

uouemmlsﬂ‘gﬁ EE “:m % ﬂ

[

|G vZ-4 Stalak ver 3.par |
LE-§T
=

-8 Ordered

514 Sketch 1 |

|32 Protrusion 2 |

LGS Skcetch 2 |

l
H

ol

[ 54 Sketch 6
Protrusion 6
0|ty Mirror 2
Hole 7
] Round 11
] Round 12

Slika 4.16 Model stalka u Solid Edge- u

type—> odabire se STL documents (*.stl) i potvrdi sa Save).

| Simulation Inspect Tools

Print.

Switch to

l:@

View

Save As Image

IPEG, TIFF), EMF, or VRML file.

Save As Translated
o
=

[ —

Ctrl+P
document.

Save for Tablet

devices.

Saves the active view as a bitmap image (BMP,

Save Model As
L. b < fied model or the flat sheet

Saves the active document as a Mon-Solid Edge

. Saves the active document for use on tablet

File name:

Save as type:

de Folders

STEP documents (*.step;".stp)
XML documents (*.plmxml) |
Adobe Acrobat documents (*.odf)

VZ-4 Stalak

STL documents (*.stl)

Farssolid documents ("o _b;"x_t)
IT documents (*t)

XGL documents (“gl)

ACIS documents (*.sat)

CATIA® V4 documents (*.model)
CATIA® V5 Part documents (*.catpart)
IFC documents (*.FC)

1GES documents (*.iges;*.igs)

Slika 4.17 Pretvaranje modela u STL dokument
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U V-REP se uveze model stalka preko (File—> Import-> Mesh

STL dokument-> Open).

3 V-REP PROEDU - Celija za bojanje robotom - rendering

| Cela za bojanje robotom

- - - i Scene hierarchy X I Selected objects: 1
IHE Edit Add Simulston Tools Plugins Add-ons S @ Celija za bojanje robotom (scene 1) 7| [[j | ®lLast selected object name: Shape B
z ; L objecttype: S e
New scene “ A e R D ora Last selected object position: x 00011y +0.0012
mD (%. ‘ ags El% Last selected object arientati -000.037 ~b: +000.03:
Open scene... a4 o Q‘:
Open recent scene 3 | Celija za bojani
Load model... Seene hierar
Close scene @ Celjazak
Defi
Save scene dprop.. q’
o- & Fe:
3
Save scene as ° @ Def
Save model as b o- & K7

Path from CSV...
Heightfield...

Slika 4.18 Uvoz 3D modela u V-REP

Ako je model nesto veéi moguce ga je smanjiti, (dvostukim klikom na model-> view/modify

geometry—> Bounding box size-> nakon unosa podataka potvrdi = Apply).

Sa Object position se dovede model na zeljenu poziciju.

Geometry associated with ‘Shape' B

Resize operation

V| Keep proportions

Bounding box size Scaling factors
X [m] |1.0262e-01 | % |+1.0000 |
¥ [m] |1.0261e-01 | ¥ |+1.0000 |
Z [m] |4.0620e-01 | a |+1.0000 |
| Apply | | Apply |

Frame orientation, rotation factors

Alpha [deg] |+0.00 |

Beta [deg] [+0.00 |
Gamma [deg] [+0.00 |

[ Apply |

Mesh info

Shape type: Simple random shape
Vertex count: 14838

Triangle count: 29700

5 Object/Item Translation/Position

1
Shape
Shape (simple, non-pure)

Mouse Translation } Position ‘ Translation

Pos. Scaling
x +0.6244 y:-12785 z+0.8225
2000037 bi+000033 gis12782 | puatvers: @ wod ) Parent frame
X-coord. [m]  |+6.2435¢-01 | | ApplyXtosel. | |
VeoordIn]  [12785e400 | [ pgpiyviose | | AP
Z<oord, [m]  |+8.2249e-01 | | ApplyZtosel. | |

T T AT

- _
§ EERw—
i
e T\

Slika 4.19 Smanjivanje modela stalka i njegovo pozicioniranje

= DeIeCien ORjects:

Slika 4.20 Prikaz polozaja modela stalka
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4.4 lzrada putanje za model stalka

Putanja je objekt koji definira stazu ili putanju u prostoru, koristi se zajedno sa objektima

»~Dummy* koji putuju po putanji koja se spaja sa kontrolnim tockama.

(Add-> Path-> Segment type—> oznaci se path i klikne na alat path edit mode l) R
—> Otvara se prozor u kojem se radi putanja, te se dodaje nova to¢ka—> Desnim klikom misa i
»Insert new control point after selection®).

¥ \-REP PRO EDU - Celija 22 bojanje robotom - rendering: & ms (2.0 fps) - SIMUL

Celija za bojanje robotom |
File Edt EES) Smulstion Tools Plugine Addons  Scenes  Help

Cantrol pairds (Fath) = Selected path poir
Primitive shape 4 = @ 7 Patt mll Aact colartard nath
%% % Joint ol = R"‘ Copy selected path points
> Modh Camera fie robatom Faste path points after selection
"' : Light ¥ fchy Delete selected path points
v bojanjz robotom {sce Cut selected path points
Q§ Point doud ) 8
0 Bpe e 0 o
Jf[xl ; Gragh E .. ) .. ) e Append new control point from camera configuration
= | Proximity sensor v e Make new path from bezier curve
i |5
L 06 Vision sensor ] E Make dummies from selected control points
: Force sensor Invert order of selected control peints
= Select all
_1, y Assodated child soipt ¥ Cirde type
y Associated customization sript Leave edit mode and cancel changes
Convex hull of selaction Leave edit mode and apply changes
Inflated convex hull of selection.
4 Convex decomposition of selection

Slika 4.21 Dodavanje tocki putanje

Nakon $to se doda druga tocka potrebno ju je pozicionirati sa Object position.

Ceifa za bojanje robotom

Cantrol points (Path) % = Selected path points: 1 (Bezier path length=0.2050) | :Pattiedigon
, Path point 1 || Last selected path point position: x +0.6000 y:-1.2000 z:+0.8500
P 3 Last selected path point orientation: a:-180.00 b:+000.00 g:-000.00 Path properties
<, Path paint 2
Path is dosed Pathis flat
V| Automatic orientation Keep X up

Control point selection

| Clear selection L Invert selection
Total path points: 1/2

Operations on selected control points
| Make dummies J
Last selected control point properties
Bezier interpolation factor 1 0.50 |
Bezier interpolation factor 2 0.500 |
Bezier point count 5 |
. \ . Virtual distance [m] |0.000e+00 |
- ﬁ Auxiliary flags o |
/ Object/Item Translation/Position n Auniiary charmeks 1.2 \o.oomwr\ 0%,000&4»00 |
— Auxiiary channels 34 0.000e400 | [0.000e400 |
Mouse Translation | Positon | Translation | Pos. Scaing =
Relative to: o World () Parent frame Apply to sek

X<oord. [m]  (+6.0000e-01 | | Apply X to sel.

fcoord. [m] (120006400 | | Apply Y tosel, | | APPY
2 e = . selection

Zcoord. [m] (485002601 | | Apply 2 tosel.

Slika 4.22 Dodavanje druge tocke putanje i pozicioniranje
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Dodavanje tre¢e to¢ke putanje dodaje se na isti nacin (Desnim klikom misa i ,,Insert new

control point after selection® = pozicionira se sa Object position).

3 V-REP PRO EDU - Celija za bojanje robotom - rendering: 14 ms (7.9 fps) - PATH EDIT MODE = X
Y jan) 9 P

¢=H::~ {% 3 @ :”O: }q”@‘@% E(?[__r‘ h ) | O |euetars - |acarate @eaity ~ [at=somseiy - | > [ [ @ & ?? 4 s Eﬁg 07@

|| celia za bojane rabotom |

D{é} Control points (Path) x J= Selected path points: - 1 (Bezier path length=0.4300) g "o edition
“Z Path point 1 ||Last selected path point position: - 4F000 y:-1.2000 z:+0.
P ; & . Lastselected path point orientation: 2 -[80.00 b:+000.00 g:-000.00 Path properties
“Z, Path point 2 = : = 3
Q5 ) ! Pathis dosed Path s fiat
|“%, Path point 3
s V| Automatic orientation KeepXup
b}
. Control point selection
[e) | Clear selection || Invert selection
Total path points: 1/3
@ Operations on selected control points
| Make dummies |
| _—
— Last selected control point properties
a Bezier interpolation factor 1 lo.so0 |
: . Bederinterpolation factor 2 lo.so0 |
:;?x Bezier point count |15 |
£ |0.000e400 |
Object/Item Translation/Position = o ]
= - Em— - - [0.000e+00 | 0.000e400 |
= Mouse Transiation | Positon | Translation | Pos. Scaiing & oooes0 | [oooceson |
) Relative to: (® world () Parent frame
e | Apply to selection
8, X-coord. [m]  (+6.0000e-01 | | Apply X tosel, |
3 B [Frerrers | | Applyto
Y-coord. [m]  |-1.2000e+00 | | Apply Y to e
Zcoord. [m]  [+6.2502e-01 | | Apy
done.
Inserting new path point...
done.
|Input Lua code here, or type "help()" (use TAB for auto-completion) sandbox script ¥ | &

Slika 4.23 Dodavanje trece tocke putanje i pozicioniranje

Prije nego se zatvori prozor za uredivanje putanje, potrebno je rad uciniti cikli¢nim.
Povezivanjem posljednje kontrolne tocke putanje s njegovom prvom kontrolnom tockom kako bi

se zatvorio put, potrebne su najmanje 3 kontrolne tocke.

Odabrati kvacicom na Path is closed—> pritiskom na X u Path edition izlazi se iz prozora za

uredivanje putanje, te nas pita da li Zelimo primjeniti promjene potvrdimo—> Yes

Celija 2a bojanje robotom |

Contral points (Path) X [I= Selected path points: 5 1 (Bezier path length=0.7163) j Patizdion
<, Path paint 1 lLast selected path point position: 000 K»] 2000  z: +0.6250 i
2 Path point 2 . Lastselected path point orientation: a-(00.00 bh:+000.00 g:-000.00 Path properties
é Path SDinta | = V! Pathis dosed Pathis flat
V| Automatic orientation Keep Xup
Control point selection
[ Clear selection il Invert selection

Total path points: 1/3

Operations on selected control points
3} Path edit mode | Mokedummies |
0 m)wishmappiy the changes? (dicking no will however st preserve extracted g P e
Beier interpolation factor 1 lo.s0 |
" Bezier interpolation factor 2 lo.s00 |
Bezier point count 115 |
Virtual distance [m] 10.000e+00 |
Auxliary flags lo |
Auxiliary channels 1-2

W Auxdliary channels 3-4

[ Apply to selection |

Slika 4.24 Povezivanje kontrolnih tocki i izlaz iz prozora za uredivanje putanje
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4.5 Upravljanje skriptom pomoéu Lua funkcija

Roboti i modeli upravljaju se pomoéu podredenih simulacijskih skripti i koriste se za
prilagodbu simulacije ili simulacijskog modela. Skripte su povezane sa scenskim objektima i
omogucuju rukovanje odredenom funkcijom u simulaciji.

(Target desni klik-> Add-> Associated child script—> Threaded).

B @ Collapse al
T— Expand selected trees
Chn Collapse selected trees

Edit
Primitive shape
Joint

i) upper_arm_visual Camera

B & foream_twisting Light
B @ foream_tistind  pymmy
m torearm_twisti point doud
BT 9 wrist

B @ wrist_respo| Octree

AY wrist_uis Graph

Proximity sensor

As: cript
Assodated customization script
Saving scene...
Saving scene (S‘;NMW\*C.'DEMMNJHH Convex hull of selection

e was sav

Scene w;

Inflated convex hull of selection...

Input Lua code here, or ty Convex decomposition of selection... auto-comple

Slika 4.25 Dodavanje skripte ,, target-u**

Nakon §to se doda skripta ,,target- u“ potrebno je upisati naredbe pomocu Lua funkcija koje
se nalaze u korisnickom priru¢niku V- REPa.
(U tabu Help—> Help topics—> otvara se V-REP User Manual).

‘elija za bojanje robotom - rendering: 15 ms (7.9 fps) - SIMULATION STOPPED
Jaton Tools Plugins Add-ons Scenes

By @-::n @ B let2.78 ~ | Acarate (gefau) + [at=somsoefay | [> ][] []

=

” Celija za b
3 Threaded child script (target)

t D wE E ()~

Slika 4.26 Izgled skripte u koju je potrebno upisati naredbe
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U izborniku se odabere (Main features> Powerful APIs, 6 languages> V-REP API
framework—> The regular AP1-> functions).

VREP User Manua V-REP main features V-REP API framework

The V-REP API framework groups all interfaces around V-REP. It comes in 5+1 different flavours:

[« _the requiar ap1 ]
« The remote API
« The ROS interfaces
+ The BlueZero interface
«+ The auxiliary APT
« Other interfaces

;fiﬁ; N - While the regular API can be accessed from within the simulator (e.g. from an embedded script, an add-

on, a plugin or the main client application), the remote API, the ROS interfaces and the BlueZero interface
can be accessed from almost any possible external application or hardware (including real robots, remote
computers, etc.). The auxiliary APT is not an interface per se, but more a collection of helper functions that
can be embedded, and that operate on their own. The otfer interfaces item groups all possibilities for the
user to extend the available interfaces. Following figure illustrates an overview of the various interfaces:

V-REP framework

Main client Embedded

application scripts
(c/c++) (Lua)

Add-ons Plugins
(Lua) (C/Cr+)

Regular AP/ Regular AP Regular API

Slika 4.27 V- REP korisnicki prirucnik sa uputstvima

Tada se otvara prozor sa svim funkcijama i parametrima koji se koriste kod Lua

programiranja u programskome alatu V- REP.

Regular API function list (alphabetical order)

Wowowowow oo

The list of API functions below allows you to access many V-REP parameters. There are however too many parameters in V-REP to have a specific
API function for each one of them. Auxiliary parameters can be accessed via a set of given functions that use object parameter IDs. Refer also to
the global parameter IDs.

simAddBanner (C

im.getObjectF: m
in. getOBjectHandle (
ObjectIncizs

sim.addobjec:
sim.addobjec

sim.addStatu =zsage (Lua)

sim.adjustView (Lua)

Womow oW oW oWoWomomoW oW W ou W oW W oWoW

sim.announceScensContentChange (Lua)

wowowow

(Lua)

Slika 4.28 V- REP funkcije za skriptu

Obrisu se zapisi u skripti (oznaci se sve i delete), sad imamo novu praznu skriptu.
Prvo je potrebno unijeti u skriptu targeta, da za putanju dohvati objekt izradenog puta kojeg smo

izradili kroz 3 kontrolne tocke po imenu ,,Path®.

U V- REP funkcijama (potrazi se sim.getObjectHandle sa Lua programskim jezikom->
otvara se prozor funkcije—> iskopira Lua synopsis = zaljepi u skriptu ,,target* i dohvaceni objekt

nazove se prema objektu u kojem je prethodno izraden put s 3 tocke ,,Path®).
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GetObjectHandle getObjectHandle

Description

C synopsis
C parameters

C return value
Lua synopsis

Retrieves an object handle based on its name. The operation of this function depends on the current
name suffix settings (see sim.getNameSuffix, sim.setNameSuffix, and the section on accessing general-
type objects). See also sim.isHandlevalid and sim.getObjectUniqueldentifier.

simInt simGetObjectHandle(const simChar* objectName)

objectName: name of object. If the name is appended by a "@alt" suffix, then the object handle
based on the object's alternative name will be retrieved. If the name is appended by a "@silentError”
suffix, then no error will be output if the object does not exist.

handle of abject or -1 if operation was not successful
number objectHandle=sim. trigo chi

Lua parameters Same as C-function Copy
Lua return values  Same as C-function Search Google for “number objectHandle=sim.getObjectHan
Remote API equiv. BO-based remote API: simxGetObjectHandle Print...

Legacy remote APL: simxGetObjectHandle

Slika 4.29 V- REP funkcija za dohvacanje objekta

Zatim je potrebno udruziti objekt ,target® sa skriptom, (preko V-REP funkcije

sim.GetObjectAssociatedWithScript-> kopira se Lua synopsis i zaljepi u drugi blok u

skripti=> u zagradi (number scriptHandle) upiSe se ,,sim.handle self za rukovanje trenutne

skripte).

GetObjectAss getObjectAss
Description Retrives the handle of the object the script is attached to. See also sim.getScriptAssociatedWithObject,
sim.getCustomizationScriptAssociatedwithObject and sim.associateScriptwithObject.
C synopsis simInt simGetObjectAssociatedWithScript(simInt scriptHandle)
C parameters scriptHandle: handle of the script
C return value Handle of the object that is associated with the script, or -1 if no object is associated with the script, or

in case of an error.

[Lua synapsis number objectHandle=sim.getObjectAssociatedWithScript (number scriptHandle) ]

Lua parameters scriptHandle: handle of the script, or ZMENFE=] for the handle of the current script
Lua return values  objectHandle: handle of the object that the script is associated with, or -1 if the script is not

associated (e.g. main scripts or add-cns don't have associated objects) or in case of an error.

Slika 4.30 Funkcija za udruzivanje objekta sa skriptom

Na Kkraju je potrebno da se objekt ,.target” pomice duz putanje ,,path“ za to ¢e se upotrijebiti

funkcija sim.followPath iz

liste funkcija.

(Iskopira se Lua synopsis—> zaljepi u skriptu u zadnji blok operacije).

FollowPa
Description
C synopsis
C parameters
C return value

Lua synopsis

Lua parameters

Lua return values

followPa

Moves an object along a path object. This function can only be called from child scripts running in a
thread (since this is a blocking operation) and is not available from the C-APL. See also sim.rmlPos,
sim.rmliVel and sim.moveToObject.

number deltaTimeLeft =8 th(number objectHandle,number pathHandle,number
positionAndOrOrientation,number relativeDistanceOnPath,number velocity,number accel
objectHandle: handle of the object to be moved

pathHandle: handle of the path object

positionAndOrOrientation: a value between 1 and 3 (1: only position is modified, 2: only orientation
is modified, 3: position and orientation is modified). Can be nil in which case 3 is applied.
relativeDistanceOnPath: a value between 0 and 1, where 0 is the beginning of the path, and 1 the
end of the path. Make sure you selected the appropriate path length calculation method (refer to the
path position calculation methed section).

velocity: movement nominal velocity.

accel: the acceleration/deceleration.

deltaTimeleft: if the time needed to follow the path is not a multiple of the simulation time step, then
deltatimeLeft is the execution time left at current simulation time. deltaTimeLeft is also memorized
internally on a thread-basis and used as compensation or correction factor in subsequent blocking
commands. deltaTimeLeft is nil in case of an error.

Slika 4.31 Funkcija za pomicanje duz putanje
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U sim.followPath funkciji potrebno je uvesti parametre, pa tako umjesto:

»humber objectHandle“ — objekt koji se premjesta upisuje se ,,Target*

,number pathHandle“ - rukovanje objekta putanje upisuje se ,,path*

,whumber positionAndOrOrientation* - ako su polozaj i orijentacija promijenjeni upisuje
se,, 3«

Lwnumber relativeDistanceOnPath* - relativna udaljenost na putanju, posto je pocetak
puta upisuje se ,, 0

,whumber velocity* - nominalna brzina kretanja upisuje se ,, 0.2 “ m/s

Lwnumber accel* - ubrzanje upisuje se,, 0.5 “ m/s?

Kad se zavrsi sa upisom parametara i naredbi dobije se gotova skripta ,,targeta® .

3} Threaded child script (target)

L O wE E )~

Slika 4.32 Skripta ,, target-a *“ sa funkcijama i parametrima
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4.6 Postavljanje rotacijskog pozicionera

Uz robot potreban je i pozicioner sa steznim napravama za pri¢vrs¢ivanje radnog komada, te

¢e oni zajedno rotirati oko z- 0SI.

Odabire se rotacijsko gibanje pozicionera (Add-> Joint-> Revolute-> Dvoklikom na
,Revolute joint“ otvaraju se postavke—> odabere se ,,Passive mode®, jer spoj nije izravno

upravljan i djelovat ¢e kao fiksna veza).

Scene Object Properties

Joint Common
File Edit Simulation Tools Plugins Add-ons Scenes Help Configuration
‘ C{H Primitive shape | Position is cydic Sarew pitch [mjdeg]  [+0.002+00 |
— Pos. min, [deg] | | Pos.range [deq] | |
. Mod{  Camera Prismatic Position [deq] | +0.000e+00 |
& |5 Light 4 Spherical Ik calculation weight [ 1.00 |
Dummy niﬁgie robotom (sc - Max. step size [deg]  [1.00e+01 |
aultCamera T
Q| | romes A #/ Revalute_jaint R
[T - kizablsFloor_5_25 - —
g oty sensor R aultlights Mode
G |6 fCameraProoy | Passive mode - Hybrid gperation
o Vision sensor ¢ kA ROBOT
& B e T Adjust dependency equation
path » path P
€, Associated chid script v ::g?yt h;!‘j‘ feiesete
P a Associated customization script rDtﬁ;y,headJesp[ Visual properties
Pr T 5 oty head vis Length [m] lo.400 | | Adjust color A |
Infiated convex hull of selection... K7 lower_arm Diameter [m] |00z | | Adjust color B |
a Conves decamnosition of selection & lower_am_re:

Apply to selection

Dynamic properties

| Show dynamic properties dialog

Slika 4.33 Dodavanje pozicionera

Sa operacijom ,,Object position“ dovede se pozicioner u poziciju radnog komada stalka.
Radni komad stalka prenese se u stablu scene pozicioneru, te time radni komad postaje ovisan o

vrtnji pozicionera koji mu je nadredeni.

Celija za bojanje robotom |

Scene hierarchy = ESE\EC\Ed ohjects 2 (frame-frame distance=0.004<
T u|Last selected ohjectname Bojanje_komada.
@ C%’f zabojanje rabotom (scene 1) = [ Last selected objecttype: Joint {revalute, p=+000.00)
DefaultCamera. Last selected object position % +0E260 y:-12750 z:+082¢
g & Bojanje_komada Last selected object orientation: 2:-000.00 b:+000.00 g:-0004

O Stalak_bojanje

Object/Item Translation/Position n He- @ ResizablsFloor_5_25

I me- & Defaultlights

Mouse Translation | Position ‘ Translation | Pos. Scaling He- & XyZCameraProxy
) ) Be-@ KUKA_ROBOT

Relative to: (&) World (! Parent frame &) base_link_visual

[ <, Path

X-coord. [m]  |+6.2500e-01 | | Apply ¥ to sel. & target = [

Y-coord. [m]  |-1.2750e+00 | | Apply ¥ tosel. :Eﬁ";i‘;ﬁ B & rotary_head

Z-coord, [m]  |+8.25008-01 | | Apply Z o sel, B @ rotary_head_respandable

A rotary_head_visual
B & lower_arm

B @ lower_arm_respondable
& lower_arm_visual
B & upper_am
B @ upper_am_respondable
&Y upper_am_visual
B & forearm_twisting
B @ forearm_twisting_respondahle
i) forearm_twisting_visual
B & wrist
B @ wist_respondable
A wrist_visual
B & axish
B1 Q =xish_respondable

Slika 4.34 Veza radnog komada i pozicionara
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Da bi postavili zajedni¢ku vrtnju radnog komada i pozicionera oko z- 0si, potrebno je

postaviti skriptu pozicioneru (Add-> Associated child script=> Non threaded).

w5 G . st EIE e U oy
@ Lala za bojans robotom (scana ) Ed i Last selected object type: Joint (revol

Last selected object position: x +0.6250 } Non-threaded child seript (Bojange_komada)
5 4/ Bojanje_kom Last selected object orientation & -000.00

Expand all

() Stalak_boj Colepoe ol 2 PO wE IR~
Bo @ ollapse al > d > *
o & Expand selected trees B} -~ if you wish to execute code contained in an extern
o & Collapse selected trees jd -- use the require-directive, e.g.:
Be- @ Edit » B = i z
@ base_link_. Primitive shape ] -—— require 'myExternalFile’
<, Path Hierarchy coloring Joint ‘W :
& target = [ Comers (] -- Above will look for <V-REP executable path>/myExte
=] o  -- <V-REP executable path>/lua/myExternalfile,lua
5@ < ] -- (the file can be cpened in this editor with the po
M rotary_head_visual Dumemy E] -— the file name)
B & Point doud
a8 ) 2 iy
& . Octree function sysCall_init()
&) lower_arm_visual Gragh PR, 2
g & P! -- do some initialization here:
@ Proximity sensor
& upper_arm_visual Vision sensor —— Make_suzo you Fead the»uczion on"’)\ccessinq 9
2 & Force sensar -- For instance, if you wish to retrieve the hand
2 @ Path ==
) forearm_twisting_visual [EERSSpr—— T -- handle=sim.getObjectHandle ('sceneObjectName"')
=T és Aosodated customization st -
@ - = : 3 : '
N o Comvex hul of selecton = Above instruction retrieves the handle of 'sce
B & Infiated convex hull of selecton... = 5 <
. ~= Tf this scrint's nama contains a '#' l(a.a. '=a
a8 @ Convex decomposition of selection. ..

Slika 4.35 Dodavanije skripte pozicioneru

Pocetni korak je da se provjeri da li je prvo inicijalno pokretanje. Da bi se omogucéilo
pokretanje i upravljanje simulacijom potreban je osnovni kod koji Lua poziva iz glavne skripte.
Funkcija sysCall_init je kod koji je zaduzen za pripremu simulacije i izvodi se to¢no jednom,
prvi put kad se izvrSava ova skripta.

(V-REP User Manual-> 6 Programming Approaches—> main script-> upise se vrsta poziva

init koja se potrazi u padajuc¢em izborniku).

3 Mon-threaded child script (Bojanje_komada)
X P xEEN
1[REEa (simicallitypezsim.syscbiinitl) then

2 T sim.syscb_br =

3 sim.syscb_cleanup
sim.syscb_contactcallbac
sim.syscbh_customcallback

sim.syscbh_customcallback

sim.syscb_customcallback

sim.syscb_customcallback

sim.syscb_dyncallback

sim.syscb_init

fim.svsch ﬁointcallbac]c. b

Slika 4.36 Provjera inicijalnog pokretanja

Kad se provjeri da li je prvo inicijalno pokretanje, potrebno je dohvatiti objekt koji je
povezan sa skriptom.

(V- REP User Manual-> Main features—> Powerful APIs, 6 languages> V-REP API
framework—> The regular AP1-> functions—> sim.getObjectAssociatedWithScript (Lua)).

sim.getMatchingPersistentDataTags (Lua)
sim.getModelProperty (Lua)
sim.getModuleInfo (Lua)
sim.getModuleName (Lua)
sim.getNameSuffix (Lua)
sim.getNavigationMode (Lua)
zim.getObjectAssociatedWithSeript [(Tu=a)
sim.getObjectConfiguration (Lua)
sim.getCbjectChild (Lua)

Slika 4.37 Funkcija za dohvacanje objekta povezanog sa skriptom
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Iskopira se Lua synopsis u drugi blok skripte, upise se ime parametra za rukovanje trenutne

skripte ,,sim.handle_self*. I tu je kraj prvog djela naredbi.

Description Retrives the handle of the object the script is attached to. See also sim.getScriptAssociatedWithObject,
sim.getCustomizationScriptAssociatedWithObject and sim.associateScriptwithObject.

C synopsis simInt simGetObjectAssociatedWithScript(simInt scriptHandle)

C parameters scriptHandle: handle of the script

C return value Handle of the object that is associated with the script, or -1 if no object is associated with the script, or

lLua synopsis | ectHandle=sim.getObjectAssociatedWithScript (number scriptHandie)
Lua parameters scriptHandle: handle of the script, or sim.handle_self for the handle of the current script
Lua return values  objectHandle: handle of the object that the script is associated with, or -1 if the script is not
associated (e.g. main scripts or add-ons don't have associated objects) or in case of an error.
3 Non-threaded child scipt (Bojanje_komada)

T 00 ~EE 0~
if (sim call type==sim.syscb init) then

h=sim.getObjectAsscciatedWithScript (sim.handle_self)
en

Slika 4.38 Upis parametara za dohvacanje objekta sa skriptom

U drugom djelu naredbi potreban je kod sysCall_actuation koji je opcenito odgovoran za
rukovanje svim funkcijama pokretanja simulatora (inverzna kinematika, dinamika itd.). Ovaj dio
se takoder izvodi u svakom simulacijskom prolazu. Prvo se provjeri da li je inicijalizacija
izvr§ena odnosno aktivirana, ako je izvrSena nastavlje se dalje.

(V- REP User Manual-> 6 Programming Approaches—> main script-> upise se vrsta poziva

actuation koji se potrazi u padaju¢em izborniku)

} Non-threaded child script (Bojanje_komada)
2 O xE E )

C]if (sim call_ type==sim.syscb_init) then
h=sim.getObjectAssociatedWithScript (sim.handle self)

if (sim_call_ type—sim.syscb_actuatiomn) then
sim.syscbk_actuation
sim.syscb_aftercopy
sim.syscb_aftercreate
sim.syscb_afterdelete
sim.syscb_afterinstancesw
sim.syscb_aftersimulation
sim.syscb_aos_resume
sim.syscb_aos_run
sim.syscb_aos suspend

Slika 4.39 Provjera aktivacije simulacije

Definiraju se lokalne varijable klju¢nom rijeci local, te je potrebno dohvatiti vremenski korak
simulacije (virtualno vrijeme simulacije koje prolazi pri svakom prolasku simulacije glavne

skripte).
(V- REP User Manual-> Main features—> Powerful APIs, 6 languages> V-REP API

framework—> The regular API-> functions=> sim.getSimulationTimeStep (Lua)). Sa tom

funkcijom postavi se vremenski korak simulacije.
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sim.getSimulationTimeStep

Description Retrieves the simulation time step (the simulation time (i.e. not real-time) that passes at each main
script simulation pass). This value might not be constant for a given simulation.

C synopsis simFloat simGetSimulationTimeStep()

C parameters None

C return value negative value (-1.0) if operation not successful, otherwise the simulation time step

Lua synopsis number timeStep=getSimulationTimeStep()

Lua parameters Same as C-function

Lua return values Same as C-function

Remote API equiv.  BO-based remote API: simxGetSimulationTimeStep
Legacy remote APL: -

3 Non-threaded child script (Bojanje_komada)

2 O ~ 3

) ~
Tif (sim_call_type==sim.syscb_init) then

2 h=sim.getObjectAssociatedWithScript (sim.handle_self)

El | end

4

SIEJif (sim call type==sim.syscb_actuation)then
6 T ‘lﬂcal dt=sim.getSimulationTimeStep ()

7

Slika 4.40 Funkcija za vremenski korak simulacije

Druga lokalna varijabla biti ¢e da se dohvati unutarnja vrijednost kuta zakretanja zgloba.
Manipulacija objekta ¢e biti jednaka manipulaciji objekta zgloba koji je prethodno udruzen sa
skriptom (,,h*).

(V- REP User Manual-> Main features> Powerful APIs, 6 languages> V-REP API
framework—> The regular AP1-> functions—> sim.getJointPosition (Lua)).

sim.getJointPosition

Description Retrieves the intrinsic position of a joint. This function cannot be used with spherical joints (use
sim.getJointMatrix instead). See also sim.setJointPosition.

C synopsis simInt simGetJointPosition{simInt cbjectHandle,simFloat* position)

C parameters objectHandle: handle of the joint

position: intrinsic position of the joint. This is a one-dimensional value: if the joint is revolute, the
rotation angle is returned, if the joint is prismatic, the translation amount is returned, etc.

C return value -1 if operation was not successful. In a future release, a more differentiated return value might be
available

Lua synopsis number position=sim.getJointPosition{number objectHandle)

Lua parameters objectHandle: handle of the joint

Lua return values  position: intrinsic position of the joint or nil in case of an error
Remote API equiv. BO-based remote API: simxGetJointPosition
Legacy remote APL: simxGetlointPosition

} Non-threaded child script (Bojanje_komada)

2 00 ~=EE )~
i8C]if (sim call type==sim.syscb init) then

2 h=sim.getObjectAssociatedWithScript (sim.handle_self)
3
4
BICJif (sim call type==sim.syscb actuation)then
6 local dt=sim.getSimulationTimeStep ()

7 local p=sim.getJointPosition (h)‘
g

end

Slika 4.41 Funkcija za zakretanje zgloba

Upotrebom te dvije funkcije potrebna je formula koja izra¢unava novu poziciju na nacin da

se povecava vrijednost kuta zakretanja zgloba u nekom vremenu pri brzini od 0.07m/s.

} Mon-threaded child script (Bojanje_kemada)

2 O ~ =

) -

if (sim call type==sim.syscb_init) then
h=sim.getObjectAssociatedWithScript (sim.handle self)

1

end

if (sim call type==sim.syscb_actuation)then
local dt=sim.getSimulationTimeStep()
local p=sim.getJointPosition (h)
p=p+dt*0.07|

W= @ s W

Slika 4.42 Formula promjene pozicije
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Takoder potrebno je postaviti unutarnji polozaj zakretanja zgloba.

(V-REP User Manual-> Main features=> Powerful APIs, 6 languages=> V-REP API
framework—> The regular AP1-> functions—> sim.setJointPosition (Lua)).

Kopira se Lua synopsis u skriptu, upisSe se objekt koji je povezan sa skriptom (number
objectHandle —,,h*). Polozaj zgloba (kutna ili linearna vrijednost ovisno o vrsti spoja) (number

position- ,,p*).

sim.setJointPosition

Description Sets the intrinsic position of a joint. May have no effect depending on the joint mode. This function
cannot be used with spherical joints (use sim.setSphericallointMatrix instead). See also
sim.getJointPosition and sim.setlointTargetPosition.

C synopsis simInt simSetJointPosition(simInt cbjectHandle, simFloat pesition)

C parameters objectHandle: handle of the joint object
position: position of the joint (angular or linear value depending on the joint type)

C return value -1 if operation was not successful. In a future release, a more differentiated return value might be
available

Lua synopsis number result=sim.setlointPosition{number objectHandle,number position)

Lua parameters Same as C-function

Lua return values Same as C-function

Remote API equiv.  BO-based remote API: simxSetJointPosition
Legacy remote APIL: simxSetlointPosition

Slika 4.43 Funkcija postavljanja unutarnjeg poloZaja

Skripta se zavrsava naredbom ,,end®, te se zatvori prozor. (Prilog)

ZavrSetkom programiranja skripte kod pozicionera, potrebno je isprobati i vidjeti u simulaciji
da li sve radi.

Ukoliko je potrebno, povecati ili smanjiti brzinu vrtnje radnog komada, da nebi neki dijelovi

ostali neobojani zbog prebrze rotacije.

3} MNon-threaded child script (Bojanje_komada)
r O wE E {)

BE]if (sim call type==sim.syscb_init) then
h=sim.getObjectAssociatedWwithScript (sim.handle_ self)

end
Hif (sim call type==sim.syscb_actuation)then
local dt=sim.getSimulationTimeStep ()
local p=sim.getJointPosition (h)
p=ptdt*0.07
sim.setJointPosition (h,p)

3
it
5
(-]
7
8
g)
0

1

—end

Slika 4.44 Zavrsni izgled skripte pozicionera
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4.7 Prikazi dijelova postrojenja za bojanje

4.7.1 Vjesalica radnih komada stalka

Ideja je da se radni komadi transportiraju po vodilici od sa¢mare do suSare. Tom prilikom
komadi se vjese na vjeSalicu prije ulaska u sa¢maru, nakon saémarenja komad izlazi preko
vodilica koje ga vode do robota.

Izradi se prvo duza vjeSalica (Add—> Primitive shape—> Cuboid—-> Odaberu se dimenzije—>
dvostruki klik na isto otvara se Scene Object Properties—> Show dynamic properties dialog—> i

odznaci se Body is dynamic, da tijelo nema masu i da ostane u zadanoj poziciji.)

3 V-REP PRO EDU - Celija za bojanje robotom - rendering: 18 ms (8.0 fps) - SIMULATION STOPPED 2
File Edit Add Simulaton Tools Plugins Add-ons Scenes Help

}ﬁi}f’ & 3 G ig}aéo @% T ) (U O [ederar - | acarste ey~ [ar=someeriy - | D[] [ @ @ 52 4 % 5] R

Vodel bronser Cela za bojanje robotom |
Py R mj"“‘s Scene hierarchy XEE::!EC‘EIE’ Db&Ean: 2: o SN
i Siani 100 m|Lastselected object name: uboi
—— | ® £ examples ) Cgaé::n_];m]e [obotor cene 1) 1T ! Lg_s_tvsa_lsc,ﬁe,,dphgaqtyps: Shape (simple, pure (cuboid))
Q! & [ furniture o] . osition: x+01750 y:-1.2750 2:+1.0750
S| |- B3 househoid R Defa g rientation: @-00000 b:+000.00 g:-000.00
E # [ infrastructure & & Bojanje
[xl | - B3 nature A A .+ Resize operation
e Object Properties V! Keep proportions
Shepe Common Bondighacns
X[m]  [3.5000e+00
vl Yiml  [3.0000e-02
lors Z[m  [10000e02
Adjust color . Apply
Apply to selection
. Frame orientation, rotation factors
e ——
SpopsTes Alpha [deg] [r000 |
thadngangefdeg) (2.0 | Beta [deg] [t000 |
V| show edges with angle [deg] (20.0 | Hidden border Gamma [deg] o
Backface culing Invert faces |
- Apply
Wireframe
Mesh info
Aaply.toselection, Shapetype:  Pure simple shape (aiboid)
xture / geometry properties Vertexcount: 8
Adjust texture | Quick textures (selection) | Triangle count: 12
Clear textures (selection) | | View/modify geometry |
8 wiist_visual |
81 & axish
imic properties
Show dynamic properties dialog
1 p— e

Slika 4.45 [zrada vece vjesalice

Istim principom izrade se ostale dvije manje vjesalice s manjim dimenzijama, koje ¢e sluziti

za izlaz radnih komada iz saémare i ulaz u suSaru.

ettty st with Vsl Scene hierarchy X I Selected objects: 1
S B Ca oo oboon care ) 11 s seeataneciene R
Resize operation ¥ [ RiltRYEe Last selected object position: x-1.4780 y 0,750z +1.0750
@ Vjesalica Last selected object orientation: & +000.00 "b: +000.00 g:-090.00

Bl [zp rareiirs @ Viesalical

Bounding box size Scaling factors &'} Viesalicaz -

X[ml  |1.0000e+00 | X [+1.0000 | i 008051?;"':‘:?;::;: Gl

Y[m  [3.0000e-02 | Y |+1.0000 | & F "5 25

Z[m] |1.0000e02 | z |+1.0000 |

[ Apply J | aoply J

esslicas
__Viesalica?

Frame orientation, rotation factors

seser o | — N —
Beta [deg] [r000 | G @ rot espondable P == --—--
Gamma [deg] [+0.00 | & rotary_head_visual ' = --‘ ‘
Apply El (a5 -
-4 e L\ Y
T
Shepe type:  Pure simple shape (cuboid) ) -

Vertexcount: 8
Triangle count: 12

Slika 4.46 Izrada dvije manje vjesalice
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Nakon zavrSetka vjeSalice potrebno je prikazati transport radnih komada koje su prethodno

obojani robotom do susare.

Iskopira se radni komad sa pozicionerom i promjeni mu se polozaj, jedan za prikaz nakon

zavrSetka bojanja prilikom ulaska u suSaru 1 drugi komad u zamisljenoj susari.

(Oznacdi se u stablu scene ,,Bojanje_komada“—> drzi se ctrl-> ,, Stalak bojanje“—> desni klik
na oznaCeno—> Edit-> Copy selected objects—> desni klik u stablu Add-> Paste buffer->

promjeni se zeljeni poloZaj za prvi i drugi obojeni komad operacijom Object Position).

Celija za bojanje robotom | -
Scene hierarchy « [H Selacted ohjects: Object/Item Translation/Position ﬂ
@ Celija za bojanje rabotom (scene 1) (] [Jj  H|Last selected object nam)

Last eelected obj
S DefauliCamera Last selected obj

Mouse Tranglation | Positon | Transiation | Pos. Scaling

gg:::;gg Ieeteoelaly Restve s (®) Word © rerent frame
@ Viesalica? . Xecoord. [m]  [-1.4750e+00 | | Apply X to sel.
- 5 & Bojanjs_komada (= [l Y<coord. [nl | 55000601 | [ applyveosel, | | APRVE
Mouse Transiation ton | Transiabon  Pos. Scalng ! paofu‘i:ﬁi?lnz’g? — Zeoord. (] [+8.2500e-01] | | Appiy 7 to sel
Relatve to: o world Parent frame ) Stelak_bojaniel
= & Obgjeni_kamadz = [l
X<oocd. [m]  |8.5000e-01 Acply X to 38l ) 0 Stalak_bujanje?
Y<oord. fm]  |-1.2750e 400 Apgly X to sel. ;’:‘wj = e- & ResizableFloor 5 25
2<oord. ] [48.2500001 | | Agply 2 tosel 5 EI0-(_) DsifaiLighis

EHe- & XrZCameraProxy
Be- @ KUKA_ROBOT
M hase_link_vigual
<, Path
& target ]
B & rotary_head
B @ rotary_head_respandable
& rotary_head_visual
B & lower_arm
B @ lower_arm_respondable
&Y lower_arm_visual
B & upper_am

Slika 4.47 Polozaji prvog i drugog obojenog komada

Istim principom ¢e Se napraviti i sa sa¢marenim komadima (kopirati i zaljepiti), te im
izmjeniti polozaje. Prvi komad je za izlaz iz sa¢mare, a drugi je u procesu sacmarenja.
Mouse Translation | PosSon | Transiaton  Pos. Scaing

Relative to: o World Pacent frame

X-coord. [m] (4152440400 | | Avply X 10 sed

e Aoply to x I Selected objects: 1
Yooord, (] 1120356400 Aopty Y.to sl selcten | om (scene 1) (o) ) MlLast seleme’d object name: Sacmareni_komad?2
Z<oxd, [m] | 48.2299¢-01 Apply 2 to sel bty Last selected object type: Joint (revolute, p= % g
Last selected object position: x +1.8250 y:-050 Object/ltem Translation/Position E
Last selected object arientation: &:-000.00 b:+000
9 Viesalical Mouse Translation | Positon | Transiation | Pos. Scaling
¥ Viesalica2

B & Bojanje_komada = [
) Stalak_bojanje

£ & Obojeni_komad! (=] [l
) Stalak_bojanjel

B & Obojeni_komad? ] Il
() Stalak_bojanje2

B & Sacmareni_komad! ][I
) Stalak_bojanjed

£ 4/ Sacmareni_komad2 | [0

) Stalak_bojanjes

Ho- & Res oor_5_25

Relative to: ) World Parent frame
X-coord. [m]  |+1.8250e+00 | | Apply X to sel.
Y-coord. [m]  |-5.0000e-01 | | ApplyY tosel,
+8.2500e-01 | | Apply Z to sel,

Apply to
selection
Z-coord. ]

Bo- @ KUKA T
& base_link_visual
<, Path

Slika 4.48 Polozaji prvog i drugog sacmarenog komada
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4.7.2 Salmara za CiS¢enje povrsine radnog komada

Dodavanjem planova prikazat ¢e se sa¢mara u kojoj se nalazi komad koji se prije samog
postupka bojanja dobro pocisti. Pomoc¢u kuglica ili sacme Cisti se vanjska povrSina radnog

komada od necisto¢a, masnoca, grubih povrsina...itd.

(Add-> Primitive shape—> Plane—> Upisu se dimenzije i promjeni pozicija—> Dvostrukim
klikom na objekt otvaraju se postavke objekta u kojem se promjeni boja—> Adjust color->

Ambient/diffuse component i promjeni se boja—> ukoliko Zelimo da je objekt proziran odabere se

LT3
,»Opacity®).
@ o’ S0l Y | T 7 y = - v i 4 & o @
%}o 44 T @73 (% oo (¥ T BAet278 ~ | Acarate (defadt) ~ | deS0ms (defoukt) D> @ e P = af ok
|Mode browser Celjo 73 bojane robotom
Dﬁ o W components Scene hierarchy * = |
% B equoment A
5 B examces @ Celijs za bojenje robotom (scene 1) 1 L simple; pure (plane)) Ambentjdffuse component
Q 4 [ fumire 2 RG8 = Speculer component
1 househoid O Secmers Red 0.83 3 i Dxlese conponer
[x' 5 & Infrastructur @ Viesalica . X % 3 ¢
’ S nsire . Green 100 Ry % Audiary component
5 office iten Puisalion porameters
B4 | |- 6 oter e 0.7 =
o £ people Shape Common Shnness 8
o) |5 B robons Pex | V! Opacty 0.0
E] [l mobk Visusl propertes Hoe 0.26 I Cokor name
S SR coons b % !
85 tocks raton 1. | Ext.sting 'y { pattern (default))
[0 vehicles Adyst coler uminosty  10.86 : L
R Apply to selection — s \ \
a Other propertes ) \
Shadng angle [deg] 1 20.0 | ! | 0
V' Show edges with 2.0 X
‘% S 1 Sovekeal Object/item Translstion/Position | =} - r \
43 t . Wireframe
| Mouse Translston | Positon | Translston  Pos. Scaing
=/ 9% Relatve to: ® Woid Pacent fame (= i
~ |
@ 70: Texture / geometry propertes || Xeoord, fm] | +1.8250e+00 | | Apoly X tozel : —
&* iy Adyst textize Quck | v<ood.(m] |5.0000e01 | | AgplyY tosel 2]
Cear textures (selecton) View | Z<oord, [m] +1.0950e 400 Apply 2 %0 58l
e | y— ’ \ \ \ | \
r—
Show dynamc propertes dakog ¥ l

Slika 4.49 lzrada krova sacmare

Object/ltem Transtation/Position B

1% Selected objects: 1
®iLast selected Sacmara? i
S simple, pure
X * 7. -0.500

Mouse Translation | Position

Translaton Pos. Scalng

Relative to: Parent frame

®) Word

X-cooed, [m) | 42.3250e400 Apply X to sel
Y-coced, [m) +5.0000e-01 Apply Y 1o sel.
2<coord, [m] 46.0200e-01 Apply 2 to sel

Apply to
sedection

Sacmara2

Slika 4.50 Bocne stranice sacmare

53



Izradom poda saémare dobiva se kona¢ni prikaz da je radni komad u saémari koji je
prethodno objesen na vjesalicu. Nakon postupka sa¢marenja radni komad preko vodilica izlazi iz

sa¢mare prema procesu bojanja.

o o - 8 2
7 | @R o0 @% 2N (e Bulet 278 ~ | Accurate (defoul) ¥ |dtwsOms (defo)  ~ | [> @ =

L

H

Celja 2a bojange robotom
Scene hierarchy * |5 Selected objects. 1

7 #|Last selected object name: Secrara3
@ Celija za bojanje robotom (scene 1) we Last selected objocttype: sh%ﬁw'apm(wboi
selected object position: x+1 . z
2 4 Last 0 Y0500 z 00500
@ Sacmara Last selected object onentation: :-00000 b:+00000 g:-000.00
@ Sacmaral :
Geometry associated with ‘Sscmarad | = |

Resize operaton
V' Keep proportions

Bounding box size Scaling factors
X fm] 1.0000¢ 400 x +1.0000
Yiml  1.0000e+00 Y +1.0000
2fm) 1,0000e-01 4 +1.0000
Aoply Aooly

Frame onentation, rotaton factors
Apha [deg)
Beta [deg]
Garmma [deg)
Aot

Mesh nfo
Shape type: Pure simpie shape (cuboid)
Vertex count: 8
Triange count: 12

Slika 4.51 Prikaz sa¢mare

4.7.3 Susara obojenih komada

Da bi se prethodno obojani radni komad ¢im brze posusio, potrebna je susara sa ventilatorom
koji upuhuje topli zrak. Radni komad do susare dolazi preko vodilica na vjesalici, nakon suSenja

komad se skida 1 odlaZe na siguran i paZljiv nacin.

Istim principom izraduju se planovi krova, bo¢nih stranica i poda kao i kod sa¢mare.

(Add-> Primitive shape—> Plane—> Upisu se dimenzije i promjeni pozicija—> Dvostrukim
klikom na objekt otvaraju se postavke objekta u kojem se promjeni boja—> Adjust color->

Ambient/diffuse component i promjeni se boja—> ukoliko Zelimo da je objekt proziran odabere se

,Opacity*.)
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X

3 V-REP PRO EDU - Celija za bojanje robotom - rendering: 20 ms (8.0 fps) - SIMULATION STOPPED =
File Edit Add Simulation Tools Plugins Add-ons Scenes Help

b 3 @5 @%@ T E) (0 O [aderars - [carote ey ~ [ammeray - | D> 1] [ @ a5 4 s & R

|| celfa 22 bojanse robotom
Scene hierarchy
ﬁ Celija za hojanje robotom (scene 1)
|

X [= Selected objects:
selected object nams
Last selected objectty,

efaultCamera
¥ Sacmara
¥ Sacmaral
9 Sacmara2
o9 Sacmara3
9 Susara

— &F Susaral
|~ @ Susara?

Object/Item Translation/Position

Mouse Transiation | Positon | Translation | Pos. Scaling |

Relative to: (®) world () Parent frame

¢ > RMm

X-coord. [m] | [ ApplyXtosel. |
| | Apply Y tosel. |

| | _ApplyZtosel. |

|-1.4750e +00

Apply to
selection

Y~coord. [m]

]

Z-coord. [m] | +5.0000e-02

I [} Stalak_bojanjed

& Sacmareni_komad2 | [I
) Stalak_bojanjes

@o- @ ResizableFloor_5_25

Eo- @ Defaultlights

=]
\"

7 DoF manipulator. ttm

g
@
S

-8 base_link_visual

Slika 4.52 Prikaz susare

=Seledld objects: 0

Slika 4.53 Polozaji sacmare i susare
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474 Prikaz filtera

U danasnje vrijeme izrazito se vodi briga o okoliSu i njegovom zagadenju opasnim
plinovima. Tako je i u bojanju potreban filter koji prilikom postupka usisava i zadrzava Stetne
plinove i nedozvoljava im da izlaze u prirodu.

Prvo se izrade boc¢ne stranice (Add-> Primitive shape—> Plane—> Upisu dimenzije i promjeni
pozicija—> Zatim se zarotira stranica—> Dvostrukim klikom na objekt otvaraju se postavke
objekta u kojem se promjeni boja—> Adjust color-> Ambient/diffuse component i promjeni se

boja—> ukoliko Zelimo da je objekt proziran odabere se ,,Opacity*.)

Celija za bojanje robotom

Scene hierarchy x I'= Selected objects:
[m|Last selected object nar

@ Celija za bojanje robotom (scene 1) =] Il

@ Filter
O Filterd

| Resize operation
V| Keep proportions

Bounding box size Scaling factors
X[m] | 1.0000e+00 X +1.0000
Y[ 7.0000e-01 ¥ +1.0000
Z[m  0.0000e+00 z +1.0000

Apply Apply

Frame orientation, rotation factors Object/Item Translation/Position B
Alpha [deg] 0
Mouse Translation | Positon | Transiation | Pos. Scaling }
Beta [deg] 0 i
| Gamma [deq] 20,00 Relative to: o world Parent frame 1
Apply
X<oord. [m]  |+1.1250e400 | | Apply X tosel.
Y<oord. [m]  |-1.7500e+00 | | Apply Y tosel foplylo
Mesh info 5 - . selection
b 3 Apply Z to sel.
e e S Zcoord. [m] | 46.0204e-01 | | ApplyZto
! Vertexcount: 4

Triangle count: 2

Slika 4.54 Bocne stranice filtera

Nakon bo¢nih stranica izradit ¢e se pladanj koji ¢e biti malo veci od ostalih stranica filtera.
Tako da sad sav viSak boje prilikom bojanja radnog komada pada na njega, a ne okolo ili po

podu.

g % 5 & = = =1p > =
%, oo (@ Bulet 278 ~ | Acaurate (defout) ~ | dtmS0 ms (defauit) > ® « o B O

Celia 23 bojanje robotom
Scene hierarchy
@ Celija za bojenje robotom (scene 1) ©] il

@ Filter
¥ Filter)
W Fiter1
0§ Fitter2
Resize operation
V' Keep proportions
Bounding box size Scaling factors
X[m]  1.0000e400 X +1.0000
Yim) 7.0000e01 Y +1.0000
Z[m  0.0000e+00 2 +1.0000
Apply Apply

| e |-

Object/Item Translation/Position

Frame crientation, rotation factors

(des) Mouse Translation Poston Transistion Pos. Scaing

Beta [deg]
Gamea [deg) +0.00 Relative to: ) workd Parent frame
S X<oord. [m] | +1.203-01
= Y<oord. ) |-1.7500e400 xaihe

z d. 46.0204e-01
Shape type: Pure simple shape (plane) i

Vertexcount: 4
Triangle count: 2

Slika 4.55 Pladanj filtera
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Nakon $to se postavi krov filtera, potrebno je dodati prikaz usisa filtera.

(Add-> Primitive shape—> Cylinder—> postave se dimenzije i pozicionira na vrh krova filtera).

‘ Celifa 2a bojane robotom |
Scene hierarchy

1

it j = ! § Filterd

@ C.E.%La za hojanje robotom (scene 1) 2] U1 = Shape (simals, pure (Gylindsn)

DefauftCamera b w +0.6250 y:-1.9250 7 +1.2500

o Filter a:-000.00 h:+000.00 g:-000.00
ﬁ Filterl
@ Filter!

s @ Filter2

Geometry associated with Filterd B

Resize operation
V| Keep proportions
Bounding box size Sealing factors

% [m] |3.0000e-01 X |+1.0000 |

|
¥ [m] |3.0000e-01 | ¥ |+1.0000 |
Z[m] |3.0000e-01 | z |+1.0000 |
| Apply | | Apply J

Frame orientation, rotation factors
Alpha [deq] [+0.00 |
Beta [deg] |+0.00 | Mouse Translation | Position ‘Translahnn Pos. Sealing
Gamma [deg] [+0.00 |

Apply

Object/ltem Translation/Position

Relative to: (@ world ) Parent frame

X-coord. [m]  |+6.2500e-01 | | Apply X tosel.

Mesh info Y-coord. [m]  |-1.9250e+00 | | Apply ¥ to sel.
Shape type: Pure simple shape | Z-coord. [m]  |+1.2500e+00 | | Apply Z to sel.
Vertex count: 6o
Triangle count: 128

Apply to
selection

namic properties

Show dynamic properties dislog | Phelp ()" (use TAB for auto-completicn)

Slika 4.56 Usis filtera

Celija za bojanje robotom
Scene hierarchy x I Selected objects: 0
@ Celijazaboj L]
@ DefaultCamere

@ Filter

Filter0

Filter1

Filter2

Filter3

Filter4

Filters

Sacmara

Sacmaral

Sacmara2

Sacmara3

Susara

Susaral

Susara2

Susara3

Viesalica

Viesalical

Viesalica2

B & Bojanje_komada
) Stalak_bojanje

£ & Ohojeni_komadi
) Stalak_bojanjel

B & Obojeni_komad?
() Stalak_bojanje2

- & Sacmareni_komac
I Stalak_hojanjed

Q=g g= =g g= === g=q=a=g=a=d

Slika 4.57 Prikaz poloZzaja filtera
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4.7.5 Sigurnosna ograda linije za bojanje

Zi¢ana ograda kod linije za bojanje je takoder vazna stavka kod sigurnosti. Onemoguéuje

pristup ljudima kad je robot u pokretu, tek nakon Sto robot stane moze se u¢i u ¢eliju.

(Model browser—> infrastructure—> other—> handrail se odabere, posluziti ¢e za prikaz ¢elije
—> dvoklik na objekt ograde - Adjust color-> Ammbient diffuse component-> promjeni se
boja).

Prilagode se dimenzije, zarotira i prenese na zeljeno mjesto. Takoder iskopira Se za drugu

stranu, samo se promjeni pozicija.

@ rnerc R e R R
3 Last selected objecttype:

Q_! Ffller] Last selected ub{eapnsitinn:

F Filterd Last selected object orientation:

@ Filter5

& Sacmara

@ Sacmaral

Resize operation
V| Keep proportions

Bounding box size Scaling factors

X [m] 3.8100e-02 X +1.0000

Y[  [8.0000e-01 Y +1.0000
Z[m (214008400 z +1.0000
Apply Apply

Frame orientation, rotation factors
Alpha [deg] +0.00
Beta [deg] +0.00 Mouse Translation | Position | Translaton | Pos. Scaling
Gamma [deg] +0.00

Apply

Object/Item Translation/Position

Relative to: ® World Parent frame

X-coord. [m]  [+2.6000e+00 | | Apply X to sel.

Meshinfo Y-coord. [m]  |-1.3250e+00 Apply Y to sel,
Shape type:  Simplerandomsha | Z-coord. [m] | +3.8500e-01 Apply Z to sel.
Vertexcount: 176
Triangle count: 296

eeeeeeee

Slika 4.58 Izrada manje ograde
Za duzu ogradu povecéavaju se samo dimenzije prethodne ograde iskopira se i zarotira.

=!| celija za bojanje robotom

Scene hierarchy X = Selected objects: 1
9 Filter2 [|Last selected object name: Zicana_ogradal
=< Last selected objecttype: Shape (simple, non-pure)
@ Fiter3 Lsst selacted abject posiiion: % +0.2000 y:-23750 2 +03d
P Filterq Last selected object orientation: 1
¥ Filter5

o Sacmara
@ Sacmaral
eszoperaton e
V| Keep proportions S ““1x:\‘,l=“_
Bounding box size Scaling factors
X [m] 3.8100e-02 X +1.0000
Y[m]  [8.0000e-01 Y +1.0000
Z[m]  |4.8000e+00 z +1.0000
Apply Apply

“ame orientation, rotation factors | Object/Item Translation/Position
Alpha [deg] +0.00

Beta [deg] +0.00 Mouse Translation | Positon | Translation = Pos. Scaling
Gamma [deg] +0.00
Relative to: ) world Parent frame
Apply
X-coord, [m]  [+2.0000e-01 | | Apply X to sel.
eshinfo Y~oord. [m]  |-2.3750e+00 Apply Y to sel, :jﬂ’u;ﬁ
Shapetype:  Smplerandomsha | Z-coord.[m] | +3.8500e-01 | | ApplyZ tosel.

Vertex count: 176

Slika 4.59 Izrada duze ograde
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4.8 Simulacija éelije za bojanje robotom

I nakon izrade ograde, dobiva se konac¢ni prikaz ¢elije za bojanje.

I'= Selected objects: 0
I

Slika 4.60 Konacni prikaz celije za bojanje

Sljedece $to preostaje je da se isproba simulacija ,,Start/resume simulation®.

O [ouet275 ~ | Acarate (@efouy) ~ [at-somseroy < | > [l [ B ﬂ}; 4 Y R
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Nakon §to se ukljuéi simulacija klikne se na postavljeni pistolj za boju ,,PaintNozzle i
otvara se izbornik sa podvrstama nanosa boje. Tijekom bojanja radnog komada moguce je
mijenjati oblike rasprsivaca kao Sto su trokutasti, kockasti, tockasti, okrugli itd. Takoder i boju

koja se zeli nanjeti na radni komad i debljinu ili koli¢inu nanosa boje.

| T L Ee
B ﬁ rotary_head
B— @ rotary_head_respondahle i
(fl ratary_head_wvisual
BT § |oweer_arm
B @ lower_arm_respondable e
[ A lower_arm_visual
BT § upper_arm
B @ upper_arm_respondahle g
—l;m upper_arm_visual
B ﬁ forearrm_twisting
B @ farearm_twisting_respondable
m forearm_twisting_wisual
Bl ﬁ it st
B @ wrist_respondable "
&Y werist_visual
Bl ﬁ axish
B (J axisb_respondable
& axish_visual
B & Force_sensor
Do GF Painthozzle (%] 1
m PaintNozzleBo

Fainttozzle

0
i~
~
i~
i~
—
o
i~
~

Slika 4.62 Podesavanje vrste i kolicine boje

PodeSavanja boje se moZe odvijati i kad nije pokrenuta simulacija, jer pistolj za boju dolazi
sa svojom pripadaju¢om skriptom u kojoj se moze isto tako podesiti Zeljena boja brojéano.
Postavke se odmah primjene prije simulacije i takoder moguce ih je mijenjati u prozoru

“PaintNozzle*.

} Mon-threaded child script (PaintMozzle)

t O wEE )~

"PaintNozz
"PaintNozzleJointD"
"PaintNozzleJointl™

"PaintNozzleDialog"

Slika 4.63 Postavke u skripti pistolja za boju
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Klikom na tipku ,,Page selector otvaraju se vise manjih prozora scene iz razliitih

perspektiva. EIE

3 V-REP PRO EDU - gelija za bojanje robotem - rendering: 213 ms (3.5 fps) - SIMULATION RUNNING - X
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5. Zakljucak

Zastita od korozije i1 estetski izgled proizvoda danas na trziStu igraju veliku ulogu uz
funkcionalnost. Kupac ima na biranje kakvu vrstu povrsinske zastite zeli, ve¢inom se odlucuju za
plastificirane i bojane proizvode. Osim toga moze birati da vanjska i unutarnja povrSina bude
razli¢ite boje, te debljinu nanosa koja je minimalno 250um prema propisu kvalitete. Zbog sve
tezeg pronalaska ljudske radne snage za izlozenosti teSkim uvjetima rada dolazi do sve vece
potrebe za uvodenje robotizacije i automatizacije u proizvodnju. U pocecima napredne
tehnologije postojala je bojaznost da ¢e uzrokovati rast nezaposlenosti, ali napredak industrijskih
robota dovodi do otvaranja novih jo$ stru¢njih i kvalitetnijih radnih mjesta koja zamjenjuju ona
manja kvalificirana radna mjesta.

Primjer automatizirane ¢elije za bojanje robotom prikazana je simulacijom u programskome
alatu V-REP koji ima $iroku paletu funkcija. U korisnickom priruéniku svaka funkcija je
objasnjena kao i svi njezini parametri. Neki od modela imaju ve¢ ugradene funkcionalnosti, ali
moguce je dodati i vlastita kontroliranja objekta preko nekoliko na¢ina programiranja. Jedan od
naéina je | primjena virtualne stvarnosti koja pruza znacajne prednosti i koja ¢e u narednom
periodu dose¢i novu razinu i sve Siru primjenu na svim razinama, pa tako i u industriji. U
podrudju strojarstva se ve¢ koristi za modeliranje u novoj vizualnoj 3D percepciji u kojoj se
mogu posti¢i znacajne cjenovne ustede prije izrada prototipa, povecanje sigurnosti i ustede
materijala ukoliko se otkrije greska sklopa u ranoj fazi.

Dokazano je da roboti poslodavcu predstavljaju manji troSak od klasicnog radnika, kako su u
obavljanju rutinskih radnji najces¢e to€niji od ¢ovjeka, da poboljSavaju kvalitetu proizvodnje te
minimiziraju potro$nju razli¢itih resursa i ne stvaraju otpad. Primjer linije za bojanje moze
posluziti dakako u velikoserijskoj proizvodnji jer za pojedinacnu nije isplativo. Danas je robotika
kljuéni pokreta¢ konkurentnosti u velikim proizvodnim industrijama.

Budu¢nost proizvodnje i daljnjim razvojem robotizacije sve manje ¢e ovisiti iskljué¢ivo o
radnoj snazi Covjeka, te ¢e s vremenom doéi da takvi sustavi potpuno zamjene radnika u
proizvodnim procesima. Strojevi ¢e proizvoditi, ali njima ¢e i dalje upravljati ljudi umnim radom

programiranjem, nadgledanjem izvodenja programa i istrazivanjem.

U Varazdinu, 07.10.2019.g. Danijel Tkalcec
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oA ZA

HLAO0N
ALISHIAINN

Sveuciliste
Sjever

SYEUZILIZTE
SIEVER

IZJAVA O AUTORSTVU
I
SUGLASNOST ZA JAVNU OBJAVU

Zavrémi/diplomski rad iskljufivo je autorsko djelo studenta koji je isti izradio te student
odgovara za istinitost, izvornost i ispravnost teksta rada. U radu se ne smiju koristiti
dijelovi tudih radova (knjiga, ¢lanaka, doktorskih disertacija, magistarskih radova, izvora s
interneta, i drugih izvora) bez navedenja izvora i autora navedenih radova. Svi dijelovi
tudih radova wmovaju biti pravilno navedeni i citirani. Dijelovi tudih radova koji nisu
pravilno citirani, smatraju se plagijatom, odnosno nezakonitim prisvajanjem tudeg
znanstvenog ili struénoga rada. Sukladno navedenom studenti su duZni potpisad izjavu o
autorstvu rada.

Ja, DAwier  Trailec (ime [ prezime) pod punom moralnom,
materijalnom i kaznenom odgovornoicu, izjavljujem da sam iskljudivi
autor/iga zavrsnog/diplomskog (obrisati nepotrebno) rada pod naslovom
Rp) ROBoTS4E CELUE 28 LAKRANSE v PROGRANSKOHE I?MTgupisati naslov) te da u
navedenom radu nisu na nedozvoljeni nacin (bé’z' zplféwilnog citiranja} koristeni
dijelovi tudih radova.

Student/ica:
(upisati ime i prezime)

Dc(/h‘llje[ Tévlo‘ec

7 e .
(vlastoruéni potpis)

Sukladno Zakonu e znanstvenoj djelatnost i visokom obrazovanju zavrine/diplomske
radove sveuéilifta su duZna trajno objaviti na javnoj internetskoj bazi sveutilidne knjiZnice
u sastavu sveudéiliSta te kopirati u javnu internetskn bazn zavrsnih/diplomskih radova
Nacionalne i sveutiliSne knjiZnice. Zavrini radovi istovrsnih umjetnitkih studija koji se
realiziraju kroz umjetniéka ostvarenja objavljuju se na edgovarajuéi nacin.

Ta, DANISEL TkALEE (ime i prezime) neopozivo izjavljujem da
sam suglasan/nd s javnom objavom zavr$nog/diplerfiskog (obrisati nepotrebno)
rada pod naslovom R82ve) ReBeTSkE Cat)E 2 LAKIRANSE v RROGRANSKoME _ (upisati
naslow) &iji sam autor/ica. mAv \=tkgp

Student/ica:
(upisati ime i prezime)

de’,‘? ( Thaliec

{vlastorudni potpis}
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8. Prilozi

Prilog 1.
V-REP kod u skripti za rotaciju pozicionera

if(sim call type==sim.syscb init)then --provjeri dali je pPrvo
inicijalno pokretanije

h=sim.getObjectAssociatedWithScript (sim.handle self) -— dohvati
objekt koji je povezan sa skriptom u zagradi parameter “ime skripte”

end

if (sim _call type==sim.syscb actuation)then - provjeri dali je
inicijalizacija izvrSena. Ako je izvrSena nastavlja dalje

local dt=sim.getSimulationTimeStep () -—— Dohvaca vremenski korak
simulacije (virtualno vrijeme simulacije koje prolazi pri svakom
prolasku simulacije glavne skripte)

local p=sim.getJointPosition (h) --Dohvac¢a unutarnju vrijednost kuta
zakretanja zgloba

p=pt+tdt*0.07 -— formula koja izracdunava novu poziciju na nacin da se
povecCava vrijednost kuta zakretanja zgloba

sim.setJointPosition (h, p) —— Postavlja unutarnji poloZaj =zakretanja
zgloba

end
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Prilog 2.

CD-R disk

70



